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Prota shall not be held responsible for any losses caused by
documentation, software, or usage errors.

In addition to Prota License Agreement Terms, it is the responsibility of
the user

e to check of results generated by documentation and software,

e make sure that the users of the software and their supervisors
have adequate technical capabilities,

e make sure that the software is used correctly per the reference
manual and documentation,

ProtaStructure is a registered trademark of Prota Software Inc. All
intellectual property rights belong to Prota Software Inc. Documentation,
training, and reference manuals, and program components can not be
copied, distributed, and used in violation of the license agreement.

ProtaStructure®, ProtaDetails®, ProtaSteel® ve ProtaBIM® are registered
trademarks of Prota Software Inc. Prota logo is a trademark of Prota
Software Inc.
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Introduction

Thank you for choosing ProtaStructure. This Quick Start Guide aims to get you up and running quickly.
You should be able to model, analyse and review the results for this simple model in around 1 hour.

User Interface

ProtaStructure 2026 welcomes you with a modern & efficient user interface designed from scratch for
ease of use. The various components of the ProtaStructure user interface are as shown below:

’- k A i

Quick fccess Ribbon Tab Command for the
- = I / — . — —— selected ribbon -
= T Ve 1eb — '|' S / N

N P [ RecentProecs CED 2 N N - & z -2 - (‘N &

+ 00 &) H B =

s G BY H i E Y e H 2 @ gt B T 7 B T -~ &

Merge Buldng LinkedModel IFC Import  DXF Import  SAF Import  Rewit ermal Matenials Settngs  Layers and Despla Project  Performance Partition  Slab Additonal  Studs  Sheetings orey
| Refresh, Rotate, Zoom [ o2l i v | S S B e g mns e &2
i o il e

Views

« [ Stucture SearCh .
Vi A Plan View
[~ T vem ® !

®

18] Storey: 4 (Roof) © ©

@ stocey: 20 ! !
R Reports ! !
3 Detal Previews ©
JF* storeys :
St:0( +-0.00m)
» © St: 1 (ground, Sim:2,3)

4 © St2(1, Sima,3)

Structure Tree o

7 Ribbed Slabs
[ tab strps * & 3*
£ Composte Siabs | i
o Stars i i

S I
!

|
®
-

i
!

TS

| |
| i
A Comectons [0) (J;J [0} (
» © St3(@25m2,1) = = =

| Status bar — reveals important information, e.g. required action to proceed H
|

Ribbon User Interface

IB- Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
7 ™ () RecentProjects - B Save <@ i H 3 - tH
- + H B P
\— (7 Open Previous Backup [ Save As E ﬁ o e =
New Open Merge Building Linked Model IFC Import DXF Import SAF Import Revit External
[&] Save Thumbnail X| Close Project Models Manager Import  Reference Drawing
Project Quick Start External Reference Drawin:

Imports an architectural plan as reference drawing to
ProtaStructure

1. Select and load the DXF file.

2, Choose the unit that the drawing has been
created

3. Specify the scale and insertion point.

The ribbon consists of several toolbars placed on various tabs. Each toolbar contains related commands
organized into logical & functional groups. Placing the mouse cursor over the command will reveal the
Tooltip explaining how to use the function.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"




(3 PROTAETENE page-7

Generally, you create the model from the left to right ribbon tab.
i.e., start with Building Setout > Modelling > Loading > Review > Analysis > Design > Drawings & Report.

Quick Access Toolbar

The Quick Access toolbar displays commonly used commands. Any command can be added to the Quick
Access toolbar by right-clicking on the command = Add to Quick Access Toolbar.

CH YN /YW @ E Q@& [
Building Setout Modelling Loading ‘Rewev: Analysis Design Drawings & Reports

H o =3 P .o ¢ N

Load Cases and Seismic Wind and Partition lab Additional Point, Line Pattern Loading
Combinations Parameters Storeyloads  Wall Loads = it Definitions
LateralLoads Add to Quick Access Toolbar

Show Quick Access Toolbar Below the Ribbon

View Operation & Structure Tree Search

View operation icons enable you to refresh the views, change rotation center & 3D display style, etc.

Place the mouse cursor on the icons to read the tooltip for details.

" 1 A e ' i
o8 LS @ G & £ Refresh Display (F6)
@ Change rotation center (F9)
i € Search . ]_ Rotate 2D Coordinate system on floor plan view
« i Structure A |'— Display Axis Indicator at screen edges always
4 f}€ Storeys .
4 © St 1(+3.00m, Sim:2,3) ty? Display Style (CTRL+D) : Rendered, Linear/Wireframe
4 |l Columns & Zoom Window (CTRL+W)
v 1C1
v 1610 C£ Zoom Previous (CTRL+P)
& Zoom Extent (CTRL+E)

Are you looking for a specific member or object? Type in the member label in the structure tree’s Search
box and let ProtaStructure find it for you.

Views
| Review Analysis Design Drawings & Reports BIM Display Views Help
P 3D = RsLxg
Reset Tile Horizontal Tile Vertical Smart Plan 3D Physical 3D Rebar
Model Model
Window Create View

Create as many views as you need, such as a plan, 3D Physical Model, Analytical Model, and 3D rebars.
Views can be organized using smart window layout options.

Customize your work area by docking and floating views. The interface is compatible with multiple
monitors. If you want to make the most of your screen’s cape, just move one of the views to another
screen.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Display Settings @ (under Building Setout tab)

Colours: Choose the background colour and various active
modelling objects

Grid: Sets the spacing of the grid system to allow ease of
modelling as objects can snap to the intersection of the
grids

Object Snap: Choose the various snap options such as
Start/End/Corner, Perpendicular or Orthogonal Grid, etc.

Graphics Performance: Options that affect graphics
performance. Defaults will give optimal performance.

Visual Interrogation =~ (under Review tab)

Visual Interrogation: Colour-code members to various
criteria such as design status, material types, beam with
wall loads. It is a vital visual tool to check and verify the
inputs and results of the model.

Scene Settings: Control the views’ graphics and switch
on/off the guiding Grids & Coordinate Axis, etc.

Visibility Filters: Filter to the specific storey, Axis, or
member type.

Column Plan Display: The column wall axial, moment &
shear forces to be displayed on the plan view.

Beam Plan Display: Allows brick/partition wall label, load
value & height to be color-coded and displayed in the plan
view. In addition, you can show the total user-defined load
(only after the analysis) & display beam elevation marks.

Slab Plan Display: The plan view shows the dead and live
load values.

Grid
Object Snap

Graphics Performance

Page - 8
Background Style: Solid v
Top Color: [ white v
—
Selection Color: I 240, 0,0 v
Highlight Color: . 240, 0, 0 v
Insertion Point Color: I Red v
Insertion Line Color: [ e v
Insertion Line Thidness: |2 v
Axds Indicator Color: [ Orange v

Visual Interrogation

Scene Settings
Entity Edges
Hiddenline Properties
Visibility Filters
Column Display
Beam Plan Display
Slab Plan Display

FE Contours

Animation

Active Windows Settings and Visual Interrogation

Criteria for recoloring: Reset All Filters

Section and Material
Column Sections
Beam Sections
Wall Thickness
Slab Thickness
Dropped Slabs (Slabs with Rel. Z)
Materials
BIM Integration
Integration Status
Loads
Beam Wall Loads
Slab Additional Dead Loads
Slab Live Loads
Members with User Defined Loads
Beams using F.E. Slab Loads
Beams Using F.E. Slab Analysis Results
Members with Temperature Difference
Design
Design Status
Design Utilization Ratios
Pile Capacity Status
Strong Column - Weak Beam Check
Joint Shear Check
Building Risk Assessment Status
Model
Wall Groups
Seismic Isolators
Seismic Isolator Type
Seismic Isolator Lateral Stiffness
Seismic Isolator Axial Stiffness

FE Contours: Shows the FE contours exported from the FE Analysis Post-Processing

Animation: Animate by spinning the model in 3D view

Each modelling window can have separate view settings.

For example, you might want to colour the slab live loads on the plan view, and at the same time, colour

design status in the 3D view.

ProtaStructure® ProtaSteel’

ProtaDetails’

ProtaBIM"




(2 PROTAEETEDE

Active Windows Settings and Visual Interrogation

Visual Interrogation
Scene Settings
Entity Edges
Hiddenline Properties
Visibility Filters
Column Display
Beam Plan Display
Slab Plan Display

FE Contours
Animation

Animate Camera

Compass

/| Coordinate Axis
Bounding Box

Page -9
D1
+ #
—————— e——t
e + #
O—Qhutia sl ——O 1
/ i :: i +\_,.-*‘“'f
.t Sl Y

/ { o—
v Grid
&— ‘
> L
> X

/| Show Axis Auto Dimensions €

In the Scene Settings tab, the grid allows you to switch on/off the grey rectangular grids in the
background. Coordinate Axis will enable you to switch on/off the coordinate symbol. Show Axis Auto
Dimensions enable to switch on/off the auto dimension between axes.

Layer Toolbars (under Display Tab)

Layer and colour settings

=7

=53

Axis Layer Group

Column Layer Group

i

ShearWall Layer Group

i

Partition Wall Layer

RC Beam Layer Group :L/J
Slab Layer Group :I:g
Ribbed Slab Layer Group 2‘%
Slab Load Layer Group g&
Slab Strip Layer Group %
Steel Bars Layer -.:—.
Steel Member Layer ?j2>
Claddings E_
Composite Slab é

ProtaStructure’

Switch on/off layers and modify the name, colour, opacity, line type, line

weight, font type, and text height.

Switch on/off the axes layer

Switch on/off the column layer

Switch on/off the wall layer

Switch on/off the partition/brick wall layer

Switch on/off the beam layer

Switch on/off the slab layer

Switch on/off the ribbed slab layer

Switch on/off the slab load layer

Switch on/off the slab strip layer

Switch on/off the slab reinforcement layer

Switch on/off steel members such as frame, truss, brace, purlins, girts, sag

rods, etc

Switch on/off roof claddings

Switch on/off composite slab

ProtaSteel’ ProtaDetails’ ProtaBIM"
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Page - 10
Ghost Axis Layer Group g—? Switch on/off the ghost axis layer
i
_ = , _—
Plane Definition Layer ST Switch on/off the plane definition layer
= .
Text Layer Group "ARC Switch on/off all the texts
Footing Layer Group E Switch on/off the footing layer
=
External Reference Drawing ! Switch on/off External Reference Drawing
When the ProtaStructure is launched, the “Start Page” will appear.
OB S AV B E0Om - & x
(e T et Drowngedms BM Do
1. 8 B & = .
Project He Quick. Ma! i e ng: Libranes toreys hd
BE: Rl @ . -
TR User Name: @ Getting Started What's New
o s 1and Sm23 .
ey uick_Start_Guide_Concrete_Com... =
4 0 SE3(2 Sm21) :,Jis:,:xz‘:m':n.;\mmaxﬁ\ 1wu ? Help Center - Training Videos
‘t ;::::m A0 Subscription expired
7 Beams Click to extend your subscription
e Pedestal_Basepiata_1 Design Guides Tips & Tricks
Eb sab stips I C\WUserstiowch\Documents\ProtaData20261T.
1 o e 100
et
o Fane G V- = e Software Updates News / Videos
B =2 sastonehDocumens Proatiszez ProfaSinicre 2025 Release Event i Banghok
;‘:::: 9.0.162 B
L pures Your software is up-to-dale.
- s Ornek_CelikMakas ProtaStructure Suite 2025 Version Comparison
N :::’“‘ CWsers\owehiDocuments ProtaData2026\ v
A Comectons to 9.0.162
© 5t 4 (Roof)

1S_Slab_Design_SP34
C\UsersiiowchiDocuments ProtaData20261.

Your software is up-to-date.

Explore ProtaStructure Suile with the Guidance of Our
Team

The Start Page contains the following functions:

7 K/ K/ 7 K/ 7
0.0 0.0 0.0 0.0 0.0 0.0

Start a new project
Read Prota News and watch Prota Videos
Access Prota Resources such as Help Centre, What's New document & Training Guide
Read important Notification and download new Software Update

View Subscription status

Open existing project

You can always open the Start Page by going to the Help tab = Start Page.

Software update is checked automatically when there is internet connection. If there is a new update,
a link will be shown, when clicked will automatically update to the latest version.

ProtaStructure’
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Starti ng a new pro;ect
» Click Open Project in the Start Page & the Open Project dialog will appear.
Here is the explanation of the functions in this dialog :
Open Project...
Project Data Folder: 1 Quick_Start_Guide_Concrete_Complete
C:\Users\lewh \Documents \ProtaData20 XX - 6 Made By:
Choose / Create Folder 3 Explore 4 Checked by
9 Al Projects Al Releases - Member Concrete Rebar Steel
Column C30/37 Grade 500 (Type 2)
Most Recently Used Projects 7 0 A-Z Date Shearwal C30/37 Grade 500 (Type 2)
x T Beam C30/37 Grade 500 (Type 2)
: Slab C30/37 Grade 500 (Type 2)
Quick_Start_Guide_Concrete_Complete >
Quick_Start_Guide_Steel_Complete 5 Bh Stb c30/37 Grade 500 (Type 2)
Footing C30/37 Grade 500 (Type 2)
Link Grade 500 (Type 2)
~ ~ + Codes:Eurocode 2 (SG).Eurocode 1 (SG).Eurocode 3 (SG)
ProtaStructure R7.0 Q
Number of Storeys:4
Project Last Saved Date:24/04/2019 11:02:12 8
(2] v X
Help oK Cancel

1. The Project Data Folder is the main folder where the project models are stored.
The project model consists of several files stored in a single folder called the Project folder. This
Project folder is created as a subfolder in the Project Data Folder. The project folder name will
always be created precisely the same as the project name.

A

A Data Folder called ProtaData20XX would be installed under My Documents by default.
If required, you can specify a different location by clicking Choose/Create Folder.
Clicking on Explore will open the current Project Data Folder in windows explorer.

You can open existing projects stored in this Data Folder by selecting the project list

After selecting the project, a preview of the project will be shown on the right-hand side
Double-clicking on the project name or clicking OK will open the project.

N

8. You can also read Project Last Saved Date to locate the saved project quickly.

Click on the dropdown list below to expose the most recent accessed Data Folders.
Tick Most Recently Used Projects to show the recent projects opened quickly.

Previous versions of ProtaStructure model can be opened directly in latest version :

>

YV V V V V

Firstly, you must choose the correct Data Folder by clicking Choose/Create Folder.

Browse to the desired Data Folder (note data folder is the main folder, not the project folder)

You will then be able to see the project and open it.

You will be prompted to save the model as another name.

After converting, the project will open.

Newer version projects can’t be opened in older versions of ProtaStructure (not backward

compatible).

ProtaStructure’
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» Click New Project " and type the project name as shown using the * ’ character for spaces.

» Select Singapore (Eurocode) template

| New Project

Project Code: | Quick_Start_Guide
! (Available Characters: A-Z, a-z, 0-9, _, -) |

| il Peru (NTE) A
3 Philippines (US Code, NSCP)
Poland (EuroCode)
Singapore (CP65)
Singapore (EuroCode)
South Africa (BS Code)
South Africa (EuroCode)
Thailand (US Code, DPT)
Turkey (TS500, TBEC2018)
Turkey (T5500, TEC2007)
United Kingdom (BS Code)
United Kingdom (EuroCode)

il

i B@nmm

E
L

ElN
Ly

8E United States (IBC, Imperial) v
@) Templates: Projects X
a v x
Help 0K Cancel

Templates are used to rapidly establish default model parameters such as design codes, material
properties, member design settings, etc. Alternatively, you can choose to duplicate settings from an
existing project by picking “Projects”.

» Click OK.

The main modelling area will now show a set of rectangular grids in the background.

%

By default, these girds spacing is 1m with a major grid coloured darker every 5m. The defaults can be

changed via the Display Setting button Eﬁ under Review tab.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Settings Center

Page - 13

The Setting Center can be accessed by clicking on the Settings icon in the Quick Access Toolbar or from
the Display tab (as shown below).

0E|ﬁm§"—

Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Wiews Help \
— u@ Recent Projects B Save p =y r'_| o5 503 -
) ; 2B B 9 P =
@ Open Previous Backup E Save As ﬁ H = BI‘B 25 {é} g
New Open . Merge Building Linked Model IFC Import DXF Import SAF Import  Revit External Materials Settings | Layers and Display
Save Thumbnail | Close Project Models Manager Import  Reference Drawing Center  [Color Settings  Settings
Project Quick Start Materials Settings

The Settings Center centralizes all the program’s default settings, including analysis, design and

detailing, and Units & format
Options
4 o ProtaStructure Environment g
|General |

Display Settings
Shortcut Key Bindings
» 3 ProtaDetails Environment

= Project Preferences
[#0 Unit and Format
» E]: Label
|z} Codes
» |2} Nationally Determined Paramet...
3H Lateral Loading
[ Lateral Drift & Bracing

» U Column & Shearwall
» ¢ Beam
» ~ Slab
» _ll, Foundation
& stairs
il Retrofit wall
» {# Steel Settings
» &2 Composite Member Settings
» [ Analytical Model Settings
» {fi* Load Editor Settings
» "H Assessment Settings

L‘,,’E Scales
» &) Rebar

» ] Plan Details

T Temnlate Mananement

settings.

General

Don't Check Model During Member Insertion

Angle Step: 5.0°
Length Step: 100 mm
Member Section Eccentricity Step: 25mm
Enable Cell Merging in Report Tables (Slow)
Member Tooltip Window
| Display Icon
/| Display Member Type
/| Display Member Label
| Display Basic Properties
v Display All Properties
Tooltip Preferences
| Show Tool Tips
Tool tip Delay (sec.): 1.0
V| Show Detailed Tool Tips
Tool tip Delay (sec.): 1.0

Export to ProtaSteel

Allow Prota Steel to Launch Without a Valid Analysis
(Connection Design won't be possible)

Language Settings
Display Language: % English v

Report Language: % English v

Plan View Direction (Project Based)
® Top Bottom

Storey Assignment Method
@) Assign the first storey with greater Z-coordinate

Assign the storey with the dosest Z-coordinate

AutoSave

Automatic Save Interval: 02

minutes

(Automatic Save Option will be Disable when Interval is '0'.)
Prompt for Automatic Saving

| Backup Structural Model

Number of Backups to Save: 3

/| Return License on Shutdown

Theme Selection

Theme: |Office 2013 v

Structure Tree

Display Sections on Structure Tree

‘v oK Cancel

For example, when you initially start a project, it’s advisable to review the Automatic Save Interval in
the General settings. By default, “0” means it’s disabled.

» Change the Automatic Save Interval to 10 minutes to ensure the model is auto-saved.

» Untick Prompt for Automatic Saving to set the auto-save to run silently in the background.

Backup Structural Model

The Number of Backups to Save refers to the automatic & silent additional backup created every full
hour. For example, the 1%t backup file will be created at 9:00 am sharp, 2" backup at 10:00 & 3™ backup
at 11:00. At 12:00 pm, the backup will overwrite the 1%t backup, and the cycle continues.

The backup zip files can be found in a folder called “Backup” in the same Project Data Folder. The files
name will have the date and time stamp (example shown below)

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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™ « Documents > ProtaData20X% > DataBackup

~

~ [ Name

;' QS5G1(R001.00032020.1400).zip

»

» T B
£7 QSG1(R001.00022020.1600).zip

»

» 3.' QSG1(R0O01.00032020.1700).zip

To restore the backup, there are 2 options :
1. If the model can be opened, go to File menu > pick Open Previous Backup.
2. If the model can’t be opened, manually extract the backup zip file and replace all files to the

same project folder, over-writing the existing files.

|

Project Template o=

Templates

The available templates are shown when you start a new project, and you must choose one. You can
access these templates via the Building Setout tab.

Templates Project Settings:
Search Project... Setting Group Active Value
8 Brazil (NBR6118) A Iz} Codes and Related Parameters Current Project Ll

mm Colombia (NSR)

= Ghana (BS Code)

3 Hong Kong (COP)

= India (Indian Codes)

== Indonesia (SNI, IBC)

== Indonesia (SNI)

B 1 Ireland (EuroCode)

B8 Macedonia (EuroCode, Et

@1 Analysis Model Parameters
ﬁ] Load Case and Combinations
[] Column Design Settings

¢ Beam Design Settings

¢ Slab Settings

O Stair Design Settings

Current Project
Current Project
Current Project
Current Project
Current Project

Current Project

3 jilli Retrofit Wall Settings Current Project
? L
& Iveort ,[1;) Footing Settings Current Project
EE Malaysia (EuroCode, EC8 T —
EE Malaysia (EuroCode) L] Export D £ Slab Additional Loads Current Project
K1 Peru (NTE) @ Partition Wall Loads Current Project
3 Philippines (NSCP.
ppines (ESCF) 99 Materials Current Project
== Poland (EuroCode) -
M singapore (CP65) =] Detail Drawing Settings Current Project
¥4 singapore (EuroCode) i@ View Settings Current Project
B= South Africa (BS Code)
et = Labels Current Project
B= South Africa (EuroCode) H]: 4
= Thailand (US Code, DPT) [#g] Unit And Format Settings Current Project
Turkey (TS500, TBEC201 g Layers Current Project
Turkey (TS500, TEC2007
| |,_(| Dimension Style Settings Current Project
My template
| p B X T Studs Current Project
Templ : P
® Templates Yojects a» Sheetings Curraat Project v
x Select Al c New Template A

Importing an existing Template - refer to step 1,2,3 above

You can change the template of a currently opened project by selecting a different template and
Importing it :

» Pick a Template (1) = Pick Select All (2) > Import (3)

All the settings of the imported template will apply to the current project.

Exporting a new Template = refer to step A, B, C, D above

You can save the settings of your current project as your template by Exporting it :

» Pick New Template (A) = Give it a name = OK - The new template will be created (B)
» Select the new template (B) = Select All (C) = Export (D)

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"



(3 PROTAETENE page- 15

The template will be successfully exported & can be re-used the next time you start a new project.

Selection Methods

Selection is performed by placing the mouse cursor on a member or Axis in the modelling view. Although
there is no entity to select now, the information is essential as you work through the model.

» Left-click on the entity to select the entity. Selected entities are also highlighted in the Structure
Tree

» To select multiple entities, hold down the CTRL key while you pick them

» You can select entities directly from the Structure Tree

You can drag with the mouse to access further selection options:

» Drag from left to right to create a rectangular box. When you release the mouse button, all
entities wholly contained within the box will be selected
» Drag from right to left similarly, and all the entities that cross its boundaries will be selected

If you right-click the selected entities, you will see a pop-out context menu that allows you to edit and
perform other tasks related to that entity, such as Properties, Delete, etc.

Pressing ESC will deselect all entities.

Zoom & Pan Methods

The useful functions for zoom are just above the structure tree :
» Zoom Window K - Zoom into the area defined by dragging a rectangle.
» Zoom Previous x —> Zoom to the previous view.

» Zoom Extents K - Zoom to the selected entities. If no entities are selected, it will zoom
to show all entities.

You will find it easiest to use the mouse wheel to:
» Zoomin -> scroll your mouse wheel up
» Zoomout - scroll the mouse wheel down
» Pan (move) -> hold down the middle mouse wheel and drag

Modelling Axes

The very first step to building a model is to define axes. Axes intersections then become the nodes at
which members are inserted. Hence, axes must be created correctly. There are three ways to model
axes:

1. Axis toolbar to build axes individually

2. External Reference Drawing to import all axes from the DXF drawing file.

3. Orthogonal Axis Generator to create a system of axes quickly

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Axis / Grid Tool .,
Modelling individual axes is simple using the program’s Dynamic Input System (DIS).

» Click on Grid icon in the Modelling tab.

There are several insertion methods for the Axis:
Axis x
o e Single Segment allows you to create a straight-line axis by clicking
L E AlS
%" Gnthe start and endpoint of the Axis.
Visible in Current Storey:

Length: H Multi-segment axis enables you to create a single axis with
Angle: multiple segments of any shape

Insertion Method:

5977 € curve Axis can be created by specifying the radius

» Ensure Single Segment insertion is selected.

» Put the mouse cursor on any of the grey grid intersections & the “Grid Intersection” snap is

shown.

_"Erid Intersection
ar

» Left-click (& release) to confirm the start point .

A “rubber band” will appear as you move your mouse cursor to specify the endpoint.

Sy= 4397 My=1715

The length (L) and local angle will be displayed during the rubber band operation. In addition,
the relative distance Ax & Ay to the local UCS will also be shown.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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» Press F2 to enable input of the length (L) of Axis via Dynamic Input System (DIS)

»  Press TAB to cycle to the following input of angle

The related parameter will be locked if a value is
entered in the textbox. You can unlock by pressing ESC
Em & or pressing the lock icon at the right of the text box.

. If a textbox is locked and F2 or ENTER is pressed, DIS
will be deactivated. However, rubber band operation
now continues with the locked parameter for ease of

&

2= 4508, &y = 3373 use.

. The left figure shows the length Lis locked,
so you can freely rotate the Axis without
changing the length.

L=5000 @ .-""

e If both text boxes are locked, pressing ENTER will accept the operation, and the candidate
point will automatically be picked.

e In either of the text boxes, you can use shortcut notation Length<Angle or Delta-X, Delta-Y
(without the need to switch by TAB.)

Length<Angle DeltaX,Delta¥ "
AO00<45 & 6000,2000 (5
o o
Poe= 3404, Ay = 2133 P = 3405, A= 2133

e Holding down the CTRL key when the rubber band appears will lock the length & angle
increment as defined in Settings Centre = ProtaStructure Environment - General = Angle
Step & Length Step input box.

» After specifying the length or angle, pressing ENTER or left-click will accept the endpoint.

» Tryinserting a multi-segment axis ™~ by defining points continuously.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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e 4000, &y = -2000

GHd Intersection
+

e Use F2, TAB, ENTER to define destination points as mentioned earlier.

e Pressing ESC will cause a smart roll-back. If parameters are locked, the DIS is unlocked, then the
operation is cancelled. If a pick-continuous command is active, ESC will unpick points.

» Right-click to end the operation and insert the axis.

e You are in axes creation mode when the axis property dialog is shown. Close it, if you want to
end the creation of an axis. The same step applies to all member properties dialog.

Insert a curve axis by clicking on the curve axis icon. 4

> Click on the 1°t point and then the 2™ point.

> Move the mouse cursor to the 3™ point that will specify the offset length of the curve.

> Left-click to confirm the 3™ point = Curve axis will be created

e Alternatively, hit F2 to specify the offset length manually.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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External Reference Drawing

Note: This section is for information. A DXF drawing is required if you want to try out this feature.

ProtaStructure lets you load external DXF drawings and show them as ghost reference layers under your
model. The External Reference Drawing button can be found under the Quick Start menu.

Building Setout Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
N ™ [ RecentProjects - [ save y N N o Y
; .- @ ,
1S Open Previous Backup E Save As ﬁ H LIFC | L n e l
New Open Merge Building Linked Model IFC Import DXF Import SAF Import Revit External
|#&] Save Thumbnail X| Close Project Models Manager Import | Reference Drawing
Project Quick Start

This tool allows you to assign DXF drawings to different stories. Properties like unit, opacity, scale factor,
and offset can be set individually for each imported file. The whole state will be saved along with the
project data and restored; the next time the project gets opened.

Important! The referenced DXF files should be intact to restore the external drawing layer next time the
project gets loaded.

Storey Reference Drawing
Active | Storey N... | File Path Unit | Use Colors | Opadity | Scale Factor | Offset
W 1 C:\Users\User\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR... mm ' =F 10 ¥ =-247.86, Y = -708.32
W 2 C:\Users\User\Documents\SAMPLES_DXF\Architectural\DURULTUCU MIMAR...  mm W == 10 ¥=0Y=0
P 4 C:\Users\User'\Documents\SAMPLES_DXF\Architectural\Architectural_Plan... . |w W —l 1.0 X=0Y=0
mm
am
m
Flease dick "Add" button to add a new external -
Add X Remove "E" Move Import | reference drawing file for a selected storey. L v X
ihd L] ihd Help F1 oK. Cancel
o

Click Add to select and load a DXF file. The file will be converted into 2D drawing entities inside
ProtaStructure directly upon loading. However, it will not be visible until the Active box is checked.

Active

This checkbox controls the visibility status of the external drawing.

Unit

Please select the correct unit of the DXF file from the table’s unit column right after the file’s loading.
The drawing will be scaled immediately.

Storey No

The imported file will be assigned to the active story initially. You can use the ‘Storey No.” column to set
it to any other level. Only one drawing can be attached to a specific storey.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Use Colours

If this field is checked, colours defined in the file will be used; a grayscale drawing is displayed if
unchecked.

Opacity

This parameter controls the opacity of the colours. This field applies only if drawing colours are selected
to be used.

Scale Factor

This factor scales the whole drawing.

Move & Offset

Click the Move button and pick two points on the plan view to move the external drawing. Dynamic
Input functionality (hit F2) can be used here as well. The offset value between the two picked points will
be shown in the Offset column of the table.

BALCUNY M
ct

nd Point e
(WS )
VY
| T

Import

The selected reference drawing can be imported into the assigned story. In this case, the Import DXF
interface will be loaded with a pre-defined level and file unit values. The drawing can be imported to
the existing model in this mode.

A complete model can be developed from scratch in a controlled environment using the External
Reference Drawing interface and Import option.

For more guidance, e.g. 3D Physical Model & 3D Analytical Model import, kindly refer to Prota Help
Centre : I[FC and DXF Import Guideline

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Orthogonal Axis Generator

Let us now start the new model by creating the required model axes. We will define multiple axes in
one go using the Orthogonal Axis Generator.

» Select all existing axes that you have created = press Delete (or right-click - Delete)

@

> Go to the Modelling tab > Select Orthogonal Axis Generator -+

Refer to the bottom status bar; the displayed text tells you how to proceed.

Pick the Reference Point (Lower /Left) of the Asxds Group...

» Pick the intersection of any two primary grids near the origin (as shown below)

_"L}‘nd Intersection
ar

Direction 1 axes are placed horizontally with alphabetic labels (incremented from bottom to top).
Direction 2 axes are aligned vertically with numeric labels (incremented from left to right).

» Accept all the default values in the inputs and click OK

Orthogonal Axis Generator

Grid Insertion

Reference Point - x: 5000 mm -y: 5000 mm

®

Insertion Angle: 0.0°

Dir-1 Axes

Axis Label: D Step: 4

®
@

Axis Spading(s): |5000%3
Axis Extension Length: 2000 mm
Dir-2 Axes
Axis Label: |1 Step: 1 |
Axis Spadng(s): |5000%3 |

Axis Extension Length: 2000 mm

Axis label increment to be used for generating the successive labels.

®

a v x

Help F1 OK Cancel

L e T B e o o o e e e e e e e

- SN0 S s '~

(=)

Four horizontal and vertical axes with a 5 m spacing will be created.

If a reversed axis label is desired, then enter “Step” = -1. For example, for Dir-1 Axes, if you want
Axis A to start from the top instead of bottom, enter “Axis Label” = D (last label) and “Step” = -1

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Columns Creation

» Pick RC Column icon U

» Use the default size b1 & b2 and eccentricity e2 & e2 is as shown below

Column x
Gen Geo
Label: Gc8|d . .
. Dir-2 Axis
Len (Storey): 1
1
bl: 500 mm C 01}111111 )
+ Reference Point
e b2: 250 mm
1
e el: 0 mm v
- b2 P . .
E::3 e 0mm e2 ! Dir-1 Axis
- v _ | — -
™ '
Bot: | D 2 f
Bot Insertion Point: | & 9| %
el
Angle: 0.0° bl
pi: (12| 1 | 2

End Releases
N V2 v3 T M2 M3

! 7 el & e2 is measure from the centroid of the column

3 7

+# Update ¥ Close

Section Manager : Allows access other section types such as circular, “L”, “T”.

7

Column End Condition : Columns ends are fixed by default. You can apply hinges to top and/or
bottom by clicking successively on this icon.

Column Concrete (500x250-C)

Database | Project General | Properties
Concrete v Section Name: | 500x250-C Material Color [ 192, 192, 192 |v
B 500.0 mm
H 250.0 mm
a 0.0°

> Hide Labels
Section Angle: \9
Mirror About:  X-X Y-Y
Materials
Conarete [Defauit]

» Insert columns by clicking on the intersection of axes
» Multiple columns can be inserted by dragging a box around the intersection of axes

Using the two methods, create ten columns at positions shown below.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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;1 ( 1_‘: ( :;1 ‘.'_;r\‘-
[ | | \

[ | | \
& _ - o ®
! ! ! ‘

[ | | \

[ | | \

[ | [ \
| | | |
[ | | \
©) (=] | | =] O]
[ | | \

[ | | \
| | | |
[ | | \

[ | | \

[ | | \

{8} . L I {8)
(8 C%i I | % (8)
| | | |
| | | \

[ | | \

[ | | \

[ | | \
| ~
SEE SEEEY SEN S
[ | | \

A A il L
) ) () *

» Close the column properties. You finish member creation.

Always close member properties when you finish member creation, otherwise you will be
unable to proceed to other functions, such as member selection.
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Walls Creation

» Click on the Wall icon a & the wall properties will appear

» Use the default wall thickness b =250mm & e =0 mm

The parameters are explained in the diagram below

>
Ext | Centroid

IwWl (3020x230)

Page - 24

ExtJ

e is measured from the centreline of the wall to its centroid. e = 0 means that the centreline of the wall

coincides with the centroid of the wall.

» Insert three walls by simply clicking on the shear wall’s start and end node.

ARENL AL ARAR
T LT L L e
© e & —©

|
®__ﬁ; _________ e —@

:

|

=
S ®

|;

® ®

wall x

Gen | Geo

T
Len (Storey): 1

[] (mm) b: . 250rnrn|
L= L

e: 0 mm

Ext. It 125 mm

= x| 125 mm |

1

Tp: | B | 2 ]

se 2]

& Update

N x[ e | 2
XK cancel

Ext | & J : Slight extension to lengthen the wall should be kept small; less than its width as the

extension cannot support any members, such as beams.

ProtaStructure” ProtaSteel
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Beams Creation

»  Click on the Beam icon & = Pick Normal =2 the beam properties will appear.

Normal

General =

Label: 1813

(mm) bz 250 mm

0mm

= h 500 mm r
== ez 0mm e-z .

I€nd | A 1

(S LI
1
}

JEnd 8 1 h

Section
Angle:

Im

Curved Beam Insertion: | - Y

Bearn Reference Point

End Releases
N V2 V3T M2 M3 b w e
1 M
7

b

Suppors Bearn Pararneters
1: | None] v
3: | [None] v

1End Free

JEnd Free

e is measured from the beam’s centreline to its sectional area centroid. e = 0 means that the beam’s
centreline coincides with its area centroid.

e-z: +ve value raise the beam from the story level, -ve lowers the beam
End Releases: Beam ends are fixed by default. To release forces (N,V,T,M), check the box(s).
<" Click successively on this icon to hinge & release all moments to the left or right end of beam.

» In the beam properties, use the defaults values b = 250 mm & h = 500 mm (as shown above)
» To create a beam, pick the start and the endpoints by clicking on the intersection of axes

Notice that you can continuously create the beams from the previous beam.

P
/ \
I‘\ 2 /I

A &
3 1
|
|

| |
L
== == — =) /b

|

> Right-click to end the beam insertion after inserting the two beams as shown above

Multiple beams can also be inserted by dragging a box enclosing the area you want to insert beams.
Beams will automatically be created between columns and walls.

!

(&)

1
7
|
|
|
|
I
?
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» Click and drag box enclosing the columns & walls shown above.

Seven (7) new beams will be created.

» Insert the rest of the beams by any method as shown below

4 j ShearWalls ) <)) (‘5‘\, \E\ 'a-
w1 |
w2 ‘

W3 [ M - - R

\
I
|
i
|
I

4 (7 Beams |
181 |

1810 |

1811 |

1812 |

1813 |

1814
1815 | ‘
1816 : l
1817 i . i i
I [

| |

@

1818
182
183 )
184 = | |
185 I |
186 |
187 | f
|
|

188
189 [
&7 Slabs :;\) .i,
- T
|

o Ribbed Slabs
s slab Strips

Check the folder Beams in the Structure Tree to ensure you have inserted a total of 18 beams.
We will now insert a curve beam in the lower right corner of the model.
» Click on the curve beam insertion icon d in the Beam Properties dialog

» Click on the intersection of axes A/3 and then the intersection of axes B/4 (i.e., start & end of the
beam)

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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050, &y =150

-1500 8

1

|
2 '

e — e — ——  ——
"
F

Page - 27

Label:

Type: [Normal v

(mm) b:

h: 600 mm

0mm

@2
&2

00

0
Crvedom mm

End Releases

N V2 v3 T M2 M3

7

« Update ¥ Close

Define the apex distance by simply moving the mouse cursor, and the preview of the curve beam in

grey will show automatically.

Press F2 to define the apex exactly as -1500 mm & press ENTER

A curve beam will be inserted (segments are automatically created). Check the Structure Tree that

you have modelled for a total of 19 beams.

(7 Beams
161
182

163

184
1B5
1B6
187
188

169

1810
1B11
1B12
1B13
1B14
1B15
1B16
1B17
1B18

1B19
./ Slabs
i Ribbed Slabs
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Beams Creation using dynamic snap points

Note: This section is optional and is not part of the final model, but you might want to try it anyway.
Secondary beams can easily be inserted using dynamic snap points (without creating axes).

> Click the Beam icon & place the cursor on the edge of the primary beam (avoid the Axis)

g

Place cursor on
edge of beam

4] o o 18I0 @ @
A

Notice that snap points on 0.25L, 0.33L, 0.5L, 0.67L, 0.75L will be shown when the cursor is placed on
the beam.

» Click on 0.67L as the start point of the secondary beam.

» Place the cursor on the destination beam

1B3-250x500

Notice that 0.25L, 0.33L, 0.5L, 0.67L, 0.75L & perpendicular point will appear

» Select the desired point as the endpoint of the secondary beam & a new beam will be created

Pressing F2 while the cursor is at any of the snap points will allow input of the exact distance from the
start of the beam.

1 /
| B B a3 250x500
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Pressing the CTRL key while the cursor is placed on the edge line of the primary beam will expose a
distance increment of 100 mm. Left-click to select the desired distance (while still holding down the
CTRL key).

S e

The step increment can be set Building Setout —> Settings Center —> ProtaStructure Environment —
General 2 Length Step.

Options
~ General
4 G ProtaStructure Environment A Don't Check Model During Member Insertion
i General Angle Step: 5.00
Display Settings
Shortcut Key Bindings Length Step:
» 3 ProtaDetails Environment Member Section Eccentricity Step: 25 mm

Handy Tip to adjust the position of columns and beams

You can change the position (eccentricity) of the column and beam by simply selecting it & then pressing
keyboard arrow keys to move in the direction you want.

/ 4 | / : » Select any column
/ / Y
/ GC 1 V GC 1 » Press right arrow key = to move the
! £
T

+ column to the right
| T T

The step by which the member is moved can be set in Building Setout -> Settings Center —>
ProtaStructure Environment —> Member Section Eccentricity Step (by default 25mm).

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Load Combinations

Before creating slabs, we need to define the load cases & combinations.

» Go to the Loading tab, click Load Cases and Combinations.

Load Combination Editor

Loading Load Cases + X
Generator Add Delete

@ Number of Combinations: 3
Edit Apply P-Delta Analysis

Page - 30
v x
oK Cancel
4

You can add new load cases manually and then load combinations. However, it's easiest to use the

Loading Generator to set up load cases and combinations automatically.

» Pick Loading Generator & use the options as shown below and click OK

| Automatic Loading Editor

Use Cracked Sections in All Vertical Load Combinations As Well
Generate Combinations for Steel Members

Add Notional Loads Combinations for Geometric Imperfections

Notional Load Factors:

V.Load Case = 10

H.Load Case =4

G: Lo| @ 0.3

Vertical Load Combinations | Horizontal Load Combinations eswemmemmsemmmsmssrel- Horizontal Load Combinations

/| Define Dead Load Case (G)

/| Define Live Load Case (Q)

| Define Pattern Loads Automatically

== .. W ==..

v/
v == Vo == =
4

Direction Dependent Pattern Loading

Define Combinations for Roof Live Load (Qr):
Define Combinations for Snow Load (S):

Define Combinations for Rain Load (R):

Stage Cases

Thermal Load

| Notional Loading

Wind Loading

Soil Pressure

NGx, NQx, NGy, NQy

Wind Load w0:

Pressure Direction

Use Cracked Sections

EN1991-1-4 [2005] (S6G)

0.6

You can choose which combination is used for concrete & steel design separately.

If “Use Cracked Sections” is checked, section stiffness factors, as defined via Material and Section
Effective Stiffness Factors menu, will be applied for that load case.
As shown below, all the load cases and combinations will automatically be generated.

ProtaStructure’
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Load Combination Editor

ULS_RC ID | Label LLRed | VOM | T... | Load Combinations

;’t:—:?e‘ 1 135G+L5Q v | & |V_1.356 + 1.5Q

SLs:SteeI 2  1.35G+1.5Qp11 v v = 1.356¢ + 1.5Qpl1
3  1.35G+1.5Qp21 v v = 1.356¢ + 1.5Qp21
4  1.35G+1.5Qp31 v v = 1.356¢ + 1.5Qp31
5  1.35G+1.5Qp41 vl | M _1.356 + 1.5Qp41
6  1.35G+1.5Qp51 vl M _1.356 + 1.5Qp51
8  1.35G+1.5Q+1.35NGx+1.5NQx v )~ 1.356 + 1.5Q + 1.35NGx + 1.5NQx
9 | 1.35G+1.5Q-1,35NGx-1.5NQx v - 1.356 + 1.5Q - 1.35NGx -  1.5NQx
10 | 1.35G+1.5Q+1.35NGy+1.5NQy v _ 1.356 + 1.5Q + 1.35NGy + 1.5NQy
11 1.35G+1.5Q-1.35NGy-1.5NQy v <. 1.356 + 1.5Q - 1.35NGy -  1.5NQy
12 1.35G+1.05Q+1.35NGx+1.05NQx v 'sl1.356 + 1.85Q + 1.35NGx + 1.05NQx
13 1.35G+1.05Q-1.35NGx-1.05NQx v 2.11.356 + 1.05Q - 1.35NGx - 1.05NQx
14 1.35G+1.05Q+1.35NGy+1.05NQy v - 1.356 + 1.85Q + 1.35NGy + 1.05NQy
15 1.35G+1.05Q-1.35NGy-1.05NQy v -.11.356 + 1.85Q 1.35NGy - 1.05NQy

| Number of Combinations: 14
GL::;adrntg o) G %+ x & of Combinations: v p'e
|eesneranet| Add Delete Edit Apply P-Delta Analysis oK Cancel

> Pick OK to save & close the Load Combination Editor.

Slab Creation

> Click on the Slab icon 7 and the slab properties dialog will appear

Slab x
»  Click on the Type box
General Loads
All the possible Slab Types will appear in pop up menu.
Label: 151{% e
Tyee: (i) | v = The slab type 1 to 12 relates the slab edge continuity and is
used in the design of the slab reinforced based on the
h: 120 mm coefficient / yield-line method.
Rel.Level: 0mm

Type 1 to 12 does not affect the slab load calculation on the
supporting beams, only the design of slab using coefficient
method.

Apply Z to Analytical Model

Conc. Cover: 25 mm

Design Angle: 0.0°

L=I One-way slab. The slab load will only to be
transferred to the 2 supporting beams in the direction of

LabelPosition

|

the span.
Insertion ..
The direction of one-way span must be specified in the
Design Angle input box : And: 0.0°
x ‘\ Beam Region ] .
+ Update ¥ Close

Rel. Level adjusts the top level of slab. Default zero means top of slab is at top of storey level. Positive
value raises the slab, vice versa.

Apply Z to Analytical Model : If checked, the adjustment of Rel. Level above will be considered in analysis,
i.e. the slab level will also be changed analytically.

Label Position icons activate the slab label and control the slab label’s position.
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Insertion method: By default, “Beam Region” is selected. This means the slab will be inserted within the
region bounded by the beams.

>

>
>

Select Slab Type as 1

For ease in creating this model, we will initially leave Slab Type as 1 for all slabs. Once they have
been created & when we are ready to design the slab, there is a function to automatically set the
correct type for each slab.

Enter the slab thickness h = 200 mm and concrete cover = 30 mm

In the Loads tab, enter Service Dead Load = 1.2 kN/m2 and Imposed Load = 3 kN/m2

Different types of service dead load can be defined via Building Setout - Libraries = Slab Additional
Loads

>

>

Position the cursor in the region bounded by beams @GL 3, 4, C, D, and left-click to create a slab.

- - 2 The first slab will be inserted.
The yield line shows the tributary area load this is
“_; :" automatically calculated onto the supporting beams.
AN By default, slab load calculation is done
automatically onto supporting beam using yield-line
< . i~ method.

Create seven more slabs to give the layout shown below

\
\
T
\
\

_+_
*
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Inserting Cantilever Slabs (Type 12)

Note: This section is optional and is not part of the final model.

Cantilever slabs can be inserted by setting Type = 12 in the slab property. They are inserted by three
clicks - clockwise or counter-clockwise direction does not matter. Cantilever slabs can span more than
one beam or wall.

» Zoom to the top-right corner of the model
» Click on Slab icon & choose Type 12 & enter h = 150mm
» Go to Cantilever tab = Enter L-Cant = 1000 mm (cantilever length)

fov 2500 @ =]
'
' ' Slab x
Slab x | |
| | .
General | Loads | Cantilever | | General Loads Cantilever
| |
Label: 1593 : | d:
|
=
| |
181 n: L0 e : : 152 - L-Cant.: 1000 mm
H Rel.Level: 0mm | 1 d=150
=120 1
Apply Z to Analytical Model | 14
| |
| | I-End:
Conc. Cover: 30 mm : : J-End:
Design Angle: 0.0° | |
Label Position : : Pa[apzt
oad:
| o o e | |
Insertion : 1 :
| b00x250) | 1C4 (5004250)
1832507500 1 ]

» Pick the first intersection of the Axis to define the start of the cantilever

» Pick a second point to define the end of the cantilever

» Move the cursor to the side where it is to be inserted = a grey preview will be shown
»  Pick the third point to confirm & insert the cantilever

To insert a cantilever slab that does not span the entire length of the beam, we must enter values of d
& b-slab in the cantilever slab properties :

» In Slab Properties, enter d = 1000 mm & b-Slab = 2000 mm

Slab x

General | Loads | Cantilever 2 \ 3
d: 1000 mm
b-Slab: 2000|mm
L-Cant 1000 mm I d _ b R
| Ll ’—
RS14
1€nd d=150
J€nd: RCE ‘ RCY

|
Parapet & ] RE2-258x5 I &
Load: [ | T

Pick the first intersection of the Axis to define the start of the cantilever

Pick a second point to determine the end of the cantilever

Move the cursor to the side where it is to be inserted = a grey preview will be shown

YV V V V

Pick the third point to confirm & insert the cantilever
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Polyline Slab/Column Edge

Note: This section is optional and is not part of the final model.
The slab edge line can be used to create irregular slab shapes
> Click Polyline Slab/Column Edge ©7 under Modelling

» Click continuously to define the edge of the cantilever slab.
| |
2 | 3

= 1000, =1 000
1 GC3 |4 GC4

3508 ] p—— {5 Intersection
= =SB8-250x -
____________ L,_,n________________________%f

The method to draw the edge lines is similar to a multi-segment axis.

» At the last point, right-click & pick Finish to end the insertion. The slab edge lines will be drawn

» Click on the Slab icon = Ensure Type = 1 is selected

Y

In the Insertion, ensure that Beam Region is selected.

» Click anywhere within the slab edge line, and a new slab will be created.

For regular cantilever slab, it is recommended to use Type 12 in slab properties (instead of slab edge
lines).

The slab/column edge line also includes Circle, Arc & Rectangle and the ability to convert to a column
or slab hole or slab drop. After drawing a closed shape line = Select it = Right-click = Convert to
Column or Slab Hole/drop.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Views Creation

The graphical editor supports multiple windows; this allows you to create different views in separate
windows. The Views tab commands can be used to create new views and to arrange the views.

Modelling Loading Review Analysis Design Drawings & Reports BIM Display Views Help
B9 | Hl &~ A
(- - 1l
Reset Tile Horizontal Tile Vertical Smart Plan [ 3D Physical f 3D Rebar ¢ t
Model Model

» Goto Views tab = Click 3D Physical Model

This command will create a 3D physical model view.
» Click Tile Vertically =2 This will tile the plan and 3D view side by side

R

=
» © 5£0(+0.00m)
4 © St1(+3.00m)

You can select & modify existing members or insert new members in the 3D view the same way as the
plan view.

To isolate the active storey in 3D view, right click anywhere on 3D view and click Isolate/Unisolate Storey

Note: Alternatively, you can right-click on Views in the Structure Tree or header field of the existing view
tabs to create new views.

4 H structure
fe .
b Zimis Axis

i

i Storey: 1
— Reports
Detail Previews

YV V V V

[E] storey: 1\@1 Plan

3D Physical Model
= 3D Rebar Model

Click Update and Close the beam properties

ProtaStructure’

ProtaSteel’

Right-click (to access the context menu) = Properties

M;

Reset Windows
Tile Horizontal
Tile Vertical

Smart

Plan

3D Physical Model
3D Rebar Model

Select the curve beam in the 3D view. Notice the same member will be selected in the plan view.

Change the depth of the beam h-bot to 600 mm (as curve beam longer than rest of the beams)

ProtaDetails’

ProtaBIM"
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Inserting Storeys & Defining Building Parameters

The final model will be a four-story building. We will now insert the other floors.

» Go to Building Setout = Storeys Operations dropdown = Insert Storey.

» Alternatively, right-click on Storey and pick Insert Storey

€ Select Storey Ag(' .
» © St: 0 (+-0.00m) E Select Storey

4]‘ T Insert Storey
-}

7 Remove Storey Eﬁ Generate StOfe‘(J
& X Delete Storey BX Delete Members in Storey
¥ s
€ Generate Storey E Remove Sto rey

2
Edit Store
= Edit Storey E Y

» Input Storey No : =4 2 OK

Add Storey

Storey No.: 4 Inserted Storey Height:

Add Intermediate Storey

Generate Members from Selected Storey

» When prompted to confirm = Pick Yes

» © St:1(+3.00m) | ™ Add New Storey

3000 mm

Page - 36

This automatically inserts stories 2, 3 & 4 with default height 3m. We will now edit the information

of the stories.

» Pick Edit Storey from the same Storey dropdown menu to enter the Edit Storey dialog

» Hold CTRL key and multiple select Storey 1, 2 & 3. Then click “Define selected stories as similar.”

Edit Storey

h Level Di D2
Info | Storey (mm) (mm) Label || Description Storey Type (m) (mm)
Cd 1 3000 3000 1 Normal 0 0
2 3000 6000 2 Normal 0 0
» 3 3000 9000 3 Normal 0 0
T 3000 12000 4 Normal 0 0
Imposed LoadReduction Similar Storey
I 1
Apply I Define Selected Storeys as Similar I l
Reset Reset

Assume Roof as Normal Storey

Storey Label that defined this fioor level.

Walll
(m2)

0.00
0.00
0.00
0.00

No.of Rigid Basements:

Wall2
(m2)

0.00
0.00
0.00
0.00

Effective Top Storey No: |4

ProtaStructure” ProtaSteel ProtaDetails’
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Imp. Load | Structural
Reduction | System Similar Storeys
0.00 RC 2,3
0.00 RC 1,3
0.00 RC 2,1
0.00 RC
1st Storey Bottom Level: 0 mm
Foundation Depth: 1100 mm
Footing Label: |F
Footing Description:
(2] v X
Help OK Cancel
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Storeys 1, 2 & 3 will now be identical. Since we have already inserted members in story 1, these
members will be automatically copied to stories 2 and 3. In addition, changes to a particular similar level
will be applied automatically to all similar stories.

For storeys to be identical, they must also have the same storey height. In an actual project, STO1 is the

ground floor & will have a shorter storey height & hence should not be made similar.

» Change the member label under the Labels column as shown above, e.g., “G” for STO1 and “R” for
ST04.

STO1 members will be labelled GB1, GC1, etc.

» Click OK to exit and notice that the 3D view shows storey 1, 2 & 3 with identical members.

Storey 4 (Roof) has no members, so that we will generate (copy) members to this storey.

» Pick Generate Storey from the same Storey dropdown

L%.%_:-_f-;; €l _ _

| Source Storey: Target Storey:
0 Storey: 1 (+3.00m) 4= x Storey: 1 (+3.00m)
‘ o Storey: 2 (+6.00m) o Storey: 2 (+6.00m)
o Storey: 3 (+9.00m) o Storey: 3 (+9.00m)
Storey: 4 (+12.00m) Storey: 4 (+12.00m) <4

Member Type to be Generated

v Columns | Slab Openings /| Braces
v Shearwalls /| Slab Strips v Girts
v Beams /| Model Lines | Purlins

Under Source Storey, pick Storey 1 & then select Storey 4 as Target Storey

Click OK, and members will be copied from the ground floor to the roof

Click Close and check that members are indeed created in storey 4

Switch to show storey 4 in the plan view by double-clicking on storey 4 in the structure tree
Create a new slab with the same properties over the lift core since this is the roof level
Press ESC to deselect all previously selected members

Right-click anywhere on the plan view to expose the context menu

YV V V V V V VYV VY

Select Member Tables — Slab Table

The slab table allows you to view & change the parameters of the slabs in a group

b Measure

E Member Tables b = Axis Table
F_:v Arrange All Steel Bars » | = Column Table
2 Wall Table
= Beam Table

2. Siab Table mmm

2 Ribbed Slab Table

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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» Click on the header q (live load), and the entire columns will be highlighted
> Click the Column-wise Edit icon at the top g
> Enter 0.75 kN/m? = press ENTER (all the slabs live load values will be changed)
» Close the Slab Table
Slab Table
All Storeys Member Search .._; X Close
h g-self ) g-Dead q Concrete Cover Angle "
Slab Type (mm) &kN/m2) Additional Dead Loads /m2) K Nfm2) (mm) (Degree) Label Vertex Do Na
4 Storey:4
R53 1 200 5.00 Enter Value... 1.20 3.00 30 0.00 0: Center
RS54 1 200 5.00 Enter Value, .. 1.20 3.00
RSS 1 200 5.00 Enter Value... 1.20 3.00 | q(kN/m2)
RS6 1 200 5.00 Enter Value... 1.20 3.00 ?5{
RS7 1 200 5.00 Enter Value... 1.20 3.00 o
RS& 1 200 5.00 Enter Value... 1.20 3.00
o T T sl o v v || X
. er Value... 1.20 3.00 oK Canced
RS511 1 200 5.00 Enter Value... 1.20 3.00

Wall Loads Library

You can set up pre-defined wall loads and then apply them using a dropdown list when adding the wall
loads.

» Go to Building Setout 2 Libraries = Partition Wall Loads @

Beam Wall Loads Library

Load Name Color Layer Name Unit Weight (kN/m3) Layer Thickness (... | Load Value (kN/m2)
100 Brick Wall - Malaysia | Brick v 20.00 130 2.60
200 Brick Wall - Malaysia =
100 Brick Wall - Singapore /
200 Brick Wall - Singapore =
300 Brick Wall ]
External Wal -
140 Block Wall [ 09 Edit Materials...
100 Block Wal = ®  EditReferences...
Float Glass Panel [~}
Tempered Glass Panel =
Laminated Glass Panel 2x -
s oK
* | x Duplicate # | x Total Load (kN/m2): 260 X Cancel

Defaults wall types are automatically set up, but you can add any new user-defined wall type.

» Choose Cancel to exit

We will now insert brick wall loading on the beams in STO1.

» Make the plan view active by clicking on it

» Double click on STO1 in the structure tree to make it active

» Select the bottom-left most perimeter beam along with Grid A / 1-2

> Click Edit Loads I'|" in the Beam tab that appears.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Member Load Editor

The load editor of the beam will appear once the load cases and combinations are generated.

N e . o GB1 - Lo c e x
¢ 3 7] [ vieldLines X = C\ v X
2 A G 1 5 [C
1G] e |
4 =) !
\Kﬁ E‘f
Load Properties 3 ‘ . ‘I Y [
<L
. 3¢ I =
[}
| 1 J
6
GB1 (5000 mm) =
’ N\
*

1. Load Types
e C(lick to choose the load type to insert, e.g., point load, full uniform load.
o Self-weight & decomposed slab loads are auto-calculated & cannot be edited.
2. Load Case & Loads Folder & Load Properties
e Choose the load case to insert the loads. Existing loads will be listed for the selected load cases.
e C(lick on the load name to select it > Right-click will expose menu options to Edit, Cut, Copy or
Remove the load.
3. Load Properties
e Enter Label, Direction & Magnitude values for the load to be created.
e Selectitin the Loads Folder or Loads diagram > Revise values > Click Update to update an existing
load.
4. Loads Diagram
e |t displays the graphical representation of the loads, including self-weight & slab loads calculated
on beams.
e Existing loads can be selected by left-clicking on the diagram > Right-clicking will expose menu
options to Edit, Cut, Copy or Remove the load.
e Click on the beam diagram to insert a load after choosing the Load Type & input values in the
Load Properties.
e The load coordinate system is shown with X, Y, Z arrows. The beam & loads diagram can be
rotated by right-clicking & drag.
5. Load Type filter
e C(lick the Load type icon to toggle on and off the associated diagrams.

6. View Options & Shortcuts

Load Types View Options

~ =5 AT 4 ». C2 p» o )
&> Solid View [i * Show Axis 17! Point Load At 5 V: Load Labels LabelTextHeight 10[$
£ Analytic View X Show Local Axis = (' Line Load 77 o Magnitude Labels  Magnitude Text Height 103

Transparency Show loads Show Infil Wall Auto Scale Frame End =
@ Orthogonal B Show Self Weigths | as merged | ¢ Areaload  |oad as Line Load Labels  Distancelabels  Distance Text Height 108

Common Display Scale Labels

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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e These settings control the rendering of the member, loads graphics, text height, scaling & frame

labels.

e Show Loads as merged "+ Loads under the same load case will be combined in a single diagram.

This option must be switched off to edit or remove the load.

3
. H I " ” o H B H H . .
e Show Infill Wall as line Load " : If “on” infill wall will be shown as line usual line loads. The infill

wall will be rendered with actual height and width if the setting is turned off.

Let us insert a 100 mm preset brick wall load on this beam :

>

>

Trapezodisll WallLoad | Fartis Delete  Report  Zoon
Lo i s

Edit Openings 100 Brick Wall - Singapore

A=
e .h( =1l AR

GB1 (5000 mm)

Update

Pick Wall Load E{ﬂ under Load Types ribbon.
Notice only the wall load type layer will be active, and all other load types will be switched off
Ensure G load case is selected in the Loads Folder at the left.

In the Load Properties, Wall Load Library, pick 100 Brick Wall - Singapore. Note wall height is preset
to 3000 mm = storey height.

Place the mouse cursor on the beam & left click to create the load.

The load will be created and added in the diagram & loads folder.

>

Press the ESC key to finish the wall load insertion process. Click OK to save & exit.

The wall load is accurately applied to the face of the column, not at the ends of the beam.

Wall Opening, e.g. of windows & doors can be inserted by clicking “Edit Openings”.

:'4

Partial wall can be entered by clicking on Partial Wall Load icon

The brick wall load will be rendered in 2D and 3D views. Notice wall load is also copied to a similar storey
as expected.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Storey Load Editor

Loads can also be entered for the entire storey, instead of a single member :

» Ensure STO1 is active & no members are selected (press ESC key)

» Go to Loading tab > Pick Load Editor Storey: 1

Building Setout Modeling Loading Review Analysis Design Drawings & Reports BIM Display Views
HJ. 123 D = —
H( (Al m B @ S = o
Load Cases and | Load Editor Wind and Non-Structural Partiton  Slab Additional Slab Load Load Decomposition
Combinations Storey: 1 Storey Loads Component Loads Wall Loads Loads Calculation Method ~ by FE
LateralLoads Load Libraries Slab Loads

The storey load editor is similar to the member’s load editor, except that all the members & loads on
the active storey are shown. The differences are described below.

wh e - 1 - 8 x
S B oW v L 2 & v X
- - :© q :©
7 l
= i
/| W
=, )
= I
T o
Load Properties 2
pa- &
= L
> X
- o
My

1. Load Types
e Surface Loads are loads are area loads that can be applied to slabs and walls
e Self-weight is auto-calculated & cannot be edited.
2. Load Case & Loads Folder
e Choose the load case to insert the loads. Existing loads will be listed for the selected load case.
e Loads folder resembles the Structure Tree, which organizes loads under member type
e Show only Loaded Members: If checked, will omit any members without any loads from listed.
e Expand the folder > Click on the load name to select it > Right-click will expose menu options to
Edit, Cut, Copy or Remove the load.
3. Member Filter
e Toggle visibility of member type in the diagram. For example, if the Beam layer is off, then all
beams & loads applied to beams will be hidden.

We will now copy the brick wall load to all the perimeter beams.
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WwNe s s Storey: 1(+3.00m, Sim:2,3) m - 0 x
Load Types View Options
B B memalLoad (Batd Al /™ Trapezodial Load ¥} Polygon Uniform Area Load
l & l o ow x
== |py Sol Load B8 wal Load @ wal Area Load
Point  Ful Uniform Partial _ Point  Uniform WallLoad  Full Uniform Rectangular Delete
¥’} Column Nodal Loads Table  .0ad load  Uniformload ok PartalWalload  Load  Load Areaload Uniform Areaload 4 Variable Surface Load Loads -
Frame Loads Surface Loads ~
Load Properties
= =
Label | 100 Brick wal - Singay ? L
Wall Load Library | 100 Brick Wal v g[] ﬂ
Edit Openings ?
Wal Unit Weight 00 im2
=
[z ¥ -
_T I T = gpy
h
SE==HN o 1
She
h-Start 3000 mm ﬁ?; ‘_E_,
o pr—
h-End 3000 mm = =
hness o
=
LI L]
i)
=, "
| g
A
= »,
AT y[ﬂ
— .

In View Options : Show Loads as merged is by default deactivated, so that the wall loads are shown
separately. Show Infill Wall load as Line Load is by default activated, so wall load is shown as line
load, instead of drawn to actual wall height.

» Choose G load case in Loads Folder.

» In Member Filter, toggle off the Slabs layer, so the slab and slab area loads are turned off.

=

» In Load Type Filter, toggle off Line Loads % & Decomposed Line Loads A@. to isolate the wall
loads

Select the partition wall load in the diagram > Right-click > Copy
Multiple select all the perimeter beams by holding down the CTRL while selecting the beams.

Right-click > Paste > Check the same wall load is pasted correctly.

YV V VY V

Go to Load Types tab > Click OK to exit the dialog.

» Examine the 2D & 3D views to ensure all wall loads are inserted correctly.

Alternatively, wall loads can also be copied in the plan view by the following steps :
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» Select beam in plan view with wall load inserted

» Right-click > Copy Loads > Select the brick wall load > OK

Li,] Copy Loads = O X
G(1) Point Load (0) 100 Brick Wall - Singapore
Area Load (0)
Line Load (0)

Thermal Load (0)
Wall Load (1)
Soil Load (0)

Select\Deselect All

Cancel

4

The load case & load type panes act as filters for selecting the load name on the right pane.

» Multiple select the perimeter beams where loads are to be pasted (holding CTRL key)
» Right-click > Paste Loads

Similar steps can be used to delete loads by selecting beams > Right-click > Delete Loads.

Defining Slab Load via Load Editor

You will learn how to insert slab line load.
» Double Click on the Storey 4 in the structure tree (to make Storey 4 active).
» Select the bottom left-most slab, RS1 > Click Edit Loads

A slab load Editor will appear. It is similar to beam load editor but with additional surface loads type.

WY& - Slab: RS1-Loads H - 0o x
Load Types View Options

& Lfd m = W o4 x =@ & v X

Point || Uniform | wall Load  Full Uniform Rectangular Polygon Uniform  Variable Delete  Report ~ Zoom Extents OK  Cancel
Load Load a Loa a3 Load oads

Areaload  Uniform Area Loa Surfaceload L

Surface Loads ~

Je +@ -
= %
i G LS
fsif GLoad =
fatt Self Weight End Pt JX
#e3 S
P
©e {827 Jaos2) L
et Q Load | ‘
Load Properties |g ‘
Label |G-3
Measurement Type  |Percent t v = Is((
Magnitude (Start) 5,000 kijm L h?
Magnitude s) 5.000 kiN/m |§§
3]
Start Pt
\ .
. . ;!
orlgln (852, 809) P
\ G3 4
Local Axis L X
Update

» Go to Loading Types tab > Click Uniform load fffl
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Note all other load type layers will automatically switch off for clarity.

» In the 3D orientation cube, click on Top E > view direction will change to top
» Ensure G load case is selected

» For Magnitude (Start) & (End) > Enter 5 kN/m

» Pick the Start point on the load > Pick the End point (approximately vertical)

The line load will be created with a default magnitude. To edit the load :
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WY& - Slab: RS1 - Loads
Load Types View Options

L1l P wm B = & X2 &K vX

Point  Uniform  Wall Load  Full Uniform Rectangular Polygon Uniform ~ Variable Delete ~ Report = Zoom Extents OK  Cancel
Load  Load Areaload  Uniform AreaLoad Areaload Surfaceload  Loads

Surface Loads

H - O X%

G vu.ﬂ

Loads A 5
4

G

fait G Load

P Sa\FWeiqht\
Load Properties

Label |G-3

Direction Gravity

| measurem entType |Distance -]

Magnitude (Start) 5.000 kN/m

Magnitude (End) 5.000 kN/m

' Insertion
X Y

Start Posiion | 1000 mm | | 1000 mm

End Position | 1000 mm | | 4000 mm

G;_l\!C-CO . 1000)

g

&
B4,

&

2

e

+ 1

zzzzzzz

» Press the ESC key to end the line load creation mode.

» Select the line load name in the load folder or the 3D diagram (rotate the view to suit).

» For Measurement Type > Choose Distance

GE:mm , Anl: kN-m , Disp:m .

The Insertion inputs will show the location & magnitude of the load in table. The X & Y inputs are with

reference to the slab origin marked by a big dot.
» Change the values as shown above > Click Update > OK to exit the dialog

The line load will also be shown in the model plan & 3D view.

oey: 4 (Plan) X - B 5

®

RB4-2501500-

REY1- 256151
miazesy —

To edit the slab load, you can select the load in plan or 3D view, Right-click > Properties.
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Defining Slab Load (via plan view)

Slab loads can also be defined on the plan view of modelling.
(
» Go to Loading tab > Click the Point, Line, and Area Loads icon -ll

The slab load properties will appear as shown below.

S osd “ > Select the Line Load icon "

LE I > Define Angle = 90 degree, length of line load, b1 = 2000 mm and Load
fgerl___2° values at start and end, wl =w2 =5 kN/m.

. ot momll % pick the intersection of axes A/1 (reference point)

[-Enter Load Manually-] v

T » Press F2 to define the relative coordinates. Enter “2500,2500” which
(atstarywi:|  GOTRID means AX = 2500 mm & AY = 2500 mm as shown below

(At End) w2: 5.0 kN/m
Q-Load Magnitudes:
(At Start) wi: 0.0 kN/m

(At End) w2: 0.0 kNjm

2500,2500 | @

«" Update XK Close -4 24—

Alternatively, you click on 2 points to define start & end of the line load (without specifying Angle & b1)

You can insert a partition wall load by clicking on the dropdown menu under “Wall” and select from the
preset wall types library

» Press ENTER & the slab line load will be created.

REH-250x500

‘ A : [ miippibgplelegor - il ekl e T

\ /

» Delete this line load by selecting it > press the DELETE key

You may use the external reference drawing to display the architectural drawing at the back of your
model as a guide for creation of members or slab load.
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Slab Opening Creation

You will learn how to define the coordinates and size of the Slab Opening.

» In STO4, zoom to slab between GL A-B/2-3.

&
> Click the Slab Opening/Drop icon = in the Modelling tab, and the slab opening properties
dialog box will appear as the figure below.

Slab Opening X
» Define the slab opening horizontal length, b1 = 1000 mm & vertical
width, b2 = 500 mm. b1: 1000 mm
b2: 500|mm
>  Pick the intersection of axes A/2 as the reference point of insertion
» Press F2 to define the relative coordinates Type: |Rectangular v
Angle
» Enter 1000,1000 which means AX = 1000 mm & AY=1000 mm in the
textbox as shown below Drop Region Definition
18 R |
ot neigof [~ |
lig |
I >
| /
|
1 + Update X Close
1000,1000 | @

[
Wik

» Press ENTER & the slab opening will be created

n
|

!
|
I

) fe? \ Ro8
e i

» Click Close in the Slab Opening Properties dialog box
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Member Re-labelling for Entire Building

The members are labelled automatically in the sequence they are created.

> To re-label the members systematically, go to Review Tab > Re-label Members

Member Re-labelling Options

Members Sort Reference
Apas Columns, Slabs, Space Trusses, Domes, Purlins, Piles Axes, Slab Strips
Direction 2 Axes:
v| Columns Left-Top --> Right-Bot Right-Top —> Left-Bot
| Shearwalls @) Left-Bot > Right-To, Right-Bot —> Left-Toj
. — : 3 - e Direction 1 Axes:
v/| Beams
Shearwalls, Beams, Frame Members, Braces, Trusses, Girts
Frame Members
Vertical Members (Y-Dir in Plan View)
/| Slabs
Left-Top --> Right-Bot Right-Top —> Left-Bot Reference Angle: 0.0°
Ribbed Slabs
ammlp> (®) Left-Bot > Right-Top Right-Bot —> Left-Top /| Group Cantilever Slabs Seperately
Composite Slabs
Trusses Horizontal Members (X-Dir in Plan View) i} Group Members by Direction
Space Trusses Left-Top —> Right-Bot Right-Top —> Left-Bot ®) Sort Rowwise
Domes — L) i;ef't_«Bot —> Right-Top Right-Bot —-> Left-Top Sort Columnwise
Braces
Girts
Modify Prefix Character sl | /| Retain Compatible Labels Between Storeys
Purlins : 3 °
Member Number Start Value: 1
Slab Strips
Piles
Storeys
First Storey:
Last Storey:
Modify Postfix Character
V| All Storeys
v X
OK Cancel

» Select all Members type
» Change all Sort Reference to Let-Bot --> Right-Top.

This means that the left-bottommost member will start with number 1.
» Tick Retain Compatible Labels Between Storeys.

This setting forces the members at the same position to have the same label across all storeys (e.g.,
1C1, 2C1, 3C1 will be at the exact location).

» Click OK.

The members will now be re-labelled systematically with label 1, starting with the left bottom-most
member.

It is common practice to have vertical member (column & wall) retain the same labels between
storeys, whereas this may not be preferred for horizontal member (beam & slab). To achieve this,
you can run the re-labelling twice for different member types with Retain Compatible Labels checked
& then unchecked.

The model is now completed, and we are ready to run the analysis.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Building Analysis

Page - 48

» Go to the Analysis tab —>click Building Analysis : — Pre-Analysis tab

Building Analysis

Unit Weight of Member:
Unit Weight of Blocks:
Coeff.of Thermal Expansion:

Codes:
Eurocode 2 (5G), Eurocode 3 (5G), Eurocode 1 (5G)

Edit Materials

25.00 kM/m3 (Column, Default)
4.41 kiN/m3
0.00005 1f°C

Building Model will be merged with the FE Foundation Model when Building Analysis is repeated.

a

Help F1

Pre-Analysis Model Options Analysis Post-Analysis Reports
Project Parameters and Loading
trr) -
& H £
Loading Wind and Storey
Settings Center CaTarin Load
Materials (Default)
Material Reinforcement Steel Grades
Columns C30/37 Grade 500 (Type 2)
Shearwalls C30/37 Grade 500 (Type 2)
Longitudinal Web Steel Grade 500 (Type 2)
Horizontal Web Steel Grade 500 (Type 2)
Beams C30/37 Grade 500 (Type 2)
Slabs C30/37 Grade 500 (Type 2)
Ribbed Slabs C30/37 Grade 500 (Type 2)
Foundations C30/37 Grade 500 (Type 2)
Links Grade 500 (Type 2)

Close

The Pre-Analysis setting is where the main assumptions of the analysis can be defined :

e Settings Center: Access settings center to review & modify analysis parameters such as the
design code and notional horizontal load.

e Load Combinations: generate, add or modify any load case or load combination sets.

e Wind and Storey Load: automatically generate wind loads, review & input any lateral load.

Automatically generated lateral loads such as the notional horizontal loads will only be
calculated and shown after the analysis.
e Edit Materials: review, add, or change the concrete and steel material of the building.
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Materials

Page - 49

We will now define the materials for this project via Building analysis> Pre-Analysis dialog.

> Pick Edit Materials

‘o Material

Default Materials
Foundation Floor

Concrete Columns

Concrete Walls

[

Longitudinal Web Bar
Horizontal Web Bar

Concrete Beams

Slabs

Rib

Links

Steel Columns

Steel Beams

Truss Members

Purlin Members

Girt Members

Brace Members
Storey Having Different & [x Frame Members
Material

Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Tvpe 2)
Grade 500 (Type 2)
Grade 500 (Type 2)
Grade 500 (Type 2)

¥ OK K cancal

The materials and reinforcement steel grades are shown for all member types. Default Material is used
for super-structure floors. A separate Foundation Floor category is automatically created for foundation

members only.

If a different material is required for a particular storey, a separate material set can be added by picking

the *

icon. Steel reinforcement grades and diameters are also defined here.

» Pick Column Concrete Grade - select C30/37 — Apply to all members in this storey - OK.

Concrete
Concrete -
C16/20 General
C20/25 Material Name
C25/30 o
C28/35 Material Color
€30/37 Mechanical Properties
C32/40
C35/45 Modulus of Elasticity
C0/50 Shear Moduus
C50/60
C60/75 Poisson's Ratio

Thermal Expansion Coeff.
Unit Weight

Design Parameters
Characteristic Compressive Strength (Fck)
Characteristic Tensile Strength (Fctk)
Material Coeff

Time Dependent Properties
Time Model
Compressive Strength and Stiffness
Creep
Shrinkage

% || X

I /| Apply to all members of this material dass in this storey, |

: C30/37

192, 192, 192 v

33000.0 N/mm2
13750.0 N/mm2
0.20

¢ 0.00005000 (1/°C)
;25000 kNjm3

: 30.00 Njmm2

1.92 N/mm2
150

: CEBFIB 90

: 0.000

: 0,000

: 0.000

¢ H cancel

» Pick Steel Grade and ensure that Grade 500 (Type 2) is selected and applied to all member types.
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Rebar

Rebar

Grade 250 (Plain)
Grade 410 (Type 2)
Grade 460 (Plain)
Grade 460 (Type 1)
Grade 460 (Type 2)
Grade 500 (Type 2)
SBPDN 930/1080
SBPDN 1080/1230
SBPDN 1275/1420

& | X

General
Material Name
Material Color

Mechanical Properties
Modulus of Elasticity
Shear Modulus
Poisson's Ratio
Thermal Expansion Coeff.
Unit Weight

Steel Bar Parameters
Minimum Yield Strength
Ultimate Strength (Fu)
Bearing Strength
Material Coeff
Rebar Symbol
Rib Type
Hook

Prestressed

Page - 50

:  Grade 500 (Type 2)

I 255, 0,0 v

© 200000.0 N/mm2

76923,0 Njmm2

: 0.30

t 0,00001200 (1/°C)

78.000 kNfm3

500.00 N/mm2
550.00 N/mm2

¢ 0.00 Nfmm2

1,15

: H

t Type2 v

Rebar Diameters

¢ Edit... I

I v ;App!y to all members of this material dass in this slnray;

« OK x Cancel

» Click “Edit...” next to Rebar Diameter & the rebar table will appear

Grade 500 (Type 2) Rebar Table

/| Column
/| Shearwall
v/| Beam
V| Slab
Rib Slab
Staircase

Footing

Links

Longitudinal Web Bar
Horizontal Web Bar
Generic

Show All

Unit: Metric

Label Diameter (mm)
10 10.0
13 13.0
16 16.0
20 20.0
25 25.0
32 32.0
40 40.0
L] x

Area (mm2)
78.54
132.732
201.062
314.159
490.874
804.248
1256.637

= O X

I ¢ ¢ o« F & a6+ s
v oW W WV v VW W o
vi oW vV v Y Y Ll
v W W W W VY
v W W v WV W Ud
v oW WV v v W v v
v W v v v vV '
v W v v CARR4 v
v OK ¥ cancel

A

» In left hand Filter pane, tick Column, Wall, Beam & Slab to hide diameters of other members

» Tick the diameters of bars to be used in the design of those members as shown above. Generic is for

all other elements, at least 1 rebar must be ticked.
» Click OK to close Rebar Table > Click OK to close Rebar dialog > OK to close Materials dialog.

Load Combinations

We have already generated the cases and load combinations previously, as shown below.
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ULS_RC ID | Label LLRed | VOM | T... | Load Combinations
;’tg—:‘:e' 1 1.356+1.5Q v M Y. 1.356 + 1.5
SLS Steel 2 1.356+1.5Qp11 v v Vv_1.356 + 1.5Qp11
- 3 1.35G+1.5Qp21 vl M - 1.356 + 1.5Qp21
4 1.35G+1.5Qp31 v/ M _1.356 + 1.5Qp31
5  1.35G+1.5Qp41 v/ W _1.356 + 1.5Qp41
6 1.35G+1.5Qp51 v/ M d_1.356 + 1.5Qp51
8  1.35G+1.5Q+1.35NGx+1.5NQx v/ 5_1.356 + 1.5Q + 1.35NGx + 1.5NQx
9  1.35G+1.5Q-1.35NGx-1.5NQx v S 1.356 + 1.5Q - 1.35NGx -  1.5NQx
10 | 1.35G+1.5Q+1.35NGy+1.5NQy v >_1.356 + 1.5Q + 1.35NGy + 1.5NQy
11 1.35G+1.5Q-1.35NGy-1.5NQy v S_1.356 + 1.5Q - 1.35NGy -  1.5NQy
12 1.35G+1.05Q+1.35NGx+105NQx [/ 5_/1.356 + 1.85Q + 1.35NGx + 1.@5NQx
13 1.35G+1.05Q-1.35NGx-1.05NQx [/ 5_1.356 +  1.85Q 1.35NGx - 1.@5NQx
14 1.35G+1.05Q+1.35NGy+L0SNQy [/ 5_/1.356 + 1.85Q + 1.35NGy + 1.@5NQy
15 1.35G+1.05Q-1.35NGy-1.05NQy = |V >_1.356 + 1.85Q - 1.35NGy - 1.85NQy

» Review & click OK to close the dialog.

Wind and Storey Loads

Allow user to review & input lateral loads such as notional horizontal & wind loads. We will skip this for
now.

Wind load cases and combinations must be generated first. For more guidance, kindly refer to Prota
Help Centre : Wind and Storey Loads

Building Analysis Model Options

» Go to the Model Options > Model = Material & Section Effective Stiffness Factors and review the
stiffness factors as shown below.

Building Analysis

Pre-Analysis Model Options Analysis | Post-Analysis Model Export Reports

Model ShearWall Model Slab Model | Settings

| I Material and Section Effective Stiffness Factors I i Default Settings
Effective Material and Section Stiffness Factors
b | Aol rea Curmany| Sheardeal TS
[ Shearwalls (Shell) 1.00 1.00 In Plane 1.00| 1.00 1.00|
1.00 1.00 Out of Plane 1.00 1.00 1.00
Shearwalls (Frame) 1.00 1.00 Major 1.00 1.00 1.00
1.00 1.00 Minor 1.00 1.00 1.00
Basement Walls 1.00 1.00 In Plane 1.00 1,00 1.00
1.00 1.00 Out of Plane 1.00 1.00 1.00
Slabs 1,00 1.00 In Plane 1.00 1.00 1.00
1.00 1.00 Out of Plane 1.00 1.00 1.00
Columns 1.00 1.00 1.00 1.00 1.00
Beams 1.00 1.00 1.00 1.00 0.01
Coupling Beams 1.00 1.00 1.00 1.00 1.00
You can modify the elasticity modulus, section areas, moment of inertias and torsional constants of the member groups to be used in the analysis
model. For example, you can enter 0.05 to reduce the moment of inertia values by 35% to reduce the lateral stiffnesses of the columns.
Note: In order to apply these factors, building analysis must be repeated. These factors will be applicable only for load cases for which aracked
section properties are used.
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The stiffnesses table will only be applied for load cases with Used Cracked Sections checked in the
respective Load Case Editor, except for seismic load cases where cracked sections are always
assumed.

All factors can be modified, except those that are greyed out, which must be auto-calculated.
Building analysis must be repeated each time the effective stiffness factors are changed.

To prevent large torsional forces in primary beams due to secondary beams, the global Torsional
Stiffness Factor is by default set to 0.01 (1%) in the Stiffnesses settings.

Stiffnesses of individual members can be changed by selecting a member = Right-click > Edit
Section/Material = Properties tab.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Running Analysis

» Go to the Analysis tab.

Page - 53

Before running the analysis, it’s always recommended to check the model’s validity.

» Click Building Model Check & pick All Storeys & click Start.

0§, Building Model Check -
/| Overlapping Slabs Check

7| Overlapping Columns Check

/| Overlapping Slabs with Beams and Walls Check

/| Columns Inside Slab Panels Check

v Overlapping Beams and Walls Check

/| valdity of Axis Intersections Check

/| Proximity of Axis Intersections Check

/| Overlapping Columns Spanning More Than One Storey Check
/| Columns and Walls with Zero Length Check

/ Repeating Member Labels Check

Check Overiaping Beams with Beams and Wals:

...Operation Completed.... Number of Errors= 0

Check Zero Clear Length Beams:

...Operation Completed.... Number of Errors= 0

Check Repeating Labels:

...Operation Completed.... Number of Errors= 0

Building Mode! Check Completed... Number of Errors= 0

Load Log to Editor l v Start

» Click Close to exit the check.

v All Storeys

Delete Orphan Corewal Panels

¥ Close

() X

The building analysis can now be performed.

Buiding Analysis
Pre-Analysis | ModelOptions | Analysis | Post-Analysis | Reports
Building Analysisand Design
=% Building Model Check X | | Building Analysis

Analysis Type: Static Analysis
Analysis Date: - Invalid —

e

Perform Eigenvalue Analysis

Display Analytical Model Before Analysis

| Refresh the Connectivity Information of All Members:

Save Foundation Column/Wall Results for Multi-block Combined Foundation Design

Axial Load Comparison Report

2]

Codes:
Eurocode 2 (SG), Eurocode 3 (5G), Eurocode 1(SG)
Help F1

Close

The building model check will pick up the most obvious
modelling errors as indicated.

The warnings / errors are mostly self-explanatory. The
exact member(s) affected will be stated.

You should review any warnings / errors and correct the
model before proceeding to perform analysis.

Click “Load Log to Editor” to open the list of
warnings/errors in a separate screen in Notepad for ease
of reference.

» Click Building Analysis

Eigenvalues analysis can be done to obtain the natural
frequencies and mode shapes of the structure.

The Batch Design Options dialog will appear.

It allows you to perform the design of column/wall &
beams automatically after the analysis.

We suggest these to be unchecked for 1st few
analyses, as result should be verified before
proceeding to design.

These options can be useful for subsequent design,
example minor amendment in model.

» Pick Building Analysis to analyse & design the model

The analysis will also check for instability and large deformations and there will warning messages if any

are found.

The Analysis Summary Report will appear at the end of the analysis, summarizing the essential results.

ProtaStructure’

ProtaSteel’

ProtaDetails’ ProtaBIM"



(3 PROTAETENE page- 54

Axial Load Comparison Report

An important check on the validity of the analysis is the Axial Load Comparison Report. This report sums
all the dead and live load applied at each storey and displays the axial forces in the columns and shear
walls. These values need to agree within a tolerance limit of 5%. If they do not, the reason for the
discrepancy should be investigated.

» Select Axial Load Comparison Report (in the Analysis tab)

TOTAL LOADS (Based On Slabs Loads):

G - Dead Loads:
Storey Column Wall Beam Slab| RibbedSlab Total
4 (+#12.00m) 9380 2531 27.39 193.7 0.00 188028
3 (+2.00m) 9380 2951 75936 1035.9% 0.00 218443
2 (+6.00m) 9380 2951 75936 1035.9% 0.00 218443
1 (+3.00m) 9380 295.31 759.36 1035.9% 0.00 216443
Total 3156

Q - Live Loads:
Storey Column Wall Beam Slab | Ribbed Slab Total
4 (+12.00m) 0.00 000 0.00 15547 0.00 15547
3 (+9.00m) 0.00 0.00 0.00 545 BB 0.00 546 B8
2 (+6.00m) 0.00 000 0.00 545 BB 0.00 546 86
1 (+3.00m) 0.00 0.00 0.00 54686 0.00 546,86
Total 1796.05

TOTAL LOADS (Decomposed to Beams):

G - Dead Loads:
Storey Column Wall Beam Slab [ Ribbed Slab Total
4 (+12.00m) 9380 50953 127783 0.00 0.00 1881.16
3 (+9.00m) 9380 40242 1689.09 0.00 0.00 218531
2 (+6.00m) 9380 40242 1689.09 0.00 0.00 218531
1 (+3.00m) 9380 40242 1689.09 000 0.00 218531
Total 8437.10

Q - Live Loads:
Storey Column Wall Beam Slab| Ribbed Slab Total
4 (+12.00m) 0.00 2813 127.34 000 0.00 15547
3 (+8.00m) 0.00 56.25 42081 0.00 0.00 54585
2 (+5.00m) 0.00 96.25 490 61 000 0.00 246.86
1 (+3.00m) 0.00 56.25 49061 0.00 0.00 54585
Total 1796.05

BUILDING ANALYSIS COLUMN AND WALL AXIAL LOADS:

Storey G Delta G Q Delta @
4 (+12.00m) 1881.16 1881.16 155.47 15547
3 (+9.00m) 408648 2185.31 702.33 686
2 (+5.00m) 625179 2185.31 124919 545 85
1 (+3.00m) 8437.10 2185.31 1796.05 54686
Totl B37.10 1796.06

Total Base Reacfions: G=8437T1kN Q=1795.06 kN

Table 1: TOTAL LOADS (Based on Slab) is the sum of dead and live loads of all members with the slab
load not yet decomposed or calculated on the beam. You can take this as the input weight of the
structure.

Table 2: TOTAL LOADS (Decomposition to Beams) consider the decomposition of the slab load onto the
beams based on either yield-line or FE Decomposition. The beam load now includes the slab loads (and
hence zero values are shown under the slab column).
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Table 3: BUILDING ANALYSIS COLUMNS AND WALL AXIAL LOADS sums up the actual column and wall

axial loads after building analysis.

Firstly, check Table 1. Total values are similar to Table 2. This ensures that beams accurately capture all

slab loads, i.e., no lost slab loads.

Then verify Table 2 total values are similar to Table 3. This ensures that all the super-structure weight is
entirely captured by the columns and walls down to the foundation.

Analytical Model

The Analytical Model enables you to review the results of the analysis graphically. It is essential to check
& verify the analytical model to ensure the model the correctly set up & results are reasonable.

» Go to the Post-Analysis tab of the Building Analysis dialog.

» Click Display Analytical Model

Alternatively, go to Analysis tab > click Analytical Model icon.

A new Analytical Model tab set will appear with the Analytical Model view.

OH > kE -

Analytical Model

g ribbon tabs

—b ,, Resit Coleftion Method
Digrams Properties

[ RRRRER | .

, NRRRRARRR R R

KR KR & R KD K RIRIR

Displacement [Resutant] - (G) - Max:0.024, Min:5.92126-05 m

_ >,
/-ﬁr*-‘ —
. \‘)}f/’ﬂ
-
I “:Z!i//ff
Load
Combinations | >

I | Ge: mm , Aci: iv-m , Disp: m

Load Combinations

Load Cases

X:-275,¥:22841 7112000 mm

The analytical wireframe is shown in blue. Load cases and combinations can be selected on the right-

side pane.

If too much information is displayed, the screen can appear cluttered. You can create a more meaningful
display view by using the various filter buttons and the view settings.

» In the General tab, click on the Filters command (if it’s not activated)

The filter options will appear on the left-hand side of the view. There are options to filter the display

by Storeys, Axes, and Member Type.

<5 @ zoomIn

A Increase Font Size

: ;3 n Tt
: n - Q Zoom Qut a7 Decrease Font Size
Settings  Flan View
& Orthogonal
Appearance

ProtaStructure” ProtaSteel

E Save Picture

‘Q] Copy Picture

o Y ~o?
lI:H
Find Filter = Connectivity
Issues

Toals
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The Find command allows you to find a particular Node, Frame, or Shell number.

Connectivity Issues lists all the frames with unsupported nodes and highlights them when selected.

» Click the Members tab.

This is where you can show node labels, rigid diaphragms, element labels, and beam loads.

® o Labels £ supports °
4 N 9" pieForces | § Springs .
Nodes Py Support
@ lLoads ==, Diaphragms Reactions
Nodes

(& then turn it off).

eNo * Rigd Members

X Local Axes

& Hinges

Frame Members

=

Al Thidness =

A" Shell No

X Local Axes -
7
Focus on Selected  Show Member
Members Only Tooltips

I N
Frame Frame Load
Loads Labels

2 Solid Model

Shell Members

Click Frame Loads & Frame Load Labels icons to show loads calculated or decomposed on the beams

This may include all the slab loads, brick wall loads, beam self-weight & other manual input loads.

Click Diaphragms -2 Select All will show the rigid diaphragm formed by the slabs (& then turn it off).

The grey lines join nodes constrained by the diaphragm to the centre of the diaphragm mass.

>
» Click on the Results tab.
p Animation s Auto Scale lx 1 R X
ry ‘9 Bi-drectional Animation L IL' 14
| Cubic Curve Lz |V

Displacements

A Shell Members

A

/ Frame Members
Diagrams

@ Nodes

o Diagrams v -

Result Collection Method | Maximum | v M

Indude Column Patch Region Results

Diagrams Slab Strips

» Click Displacement = The red lines show the structure’s displacement (deflection).

By default, Auto Scale is activated. You can deactivate this and then type in your Scale.

Displacement Unit can be changed in the Settings Centre > Units and Format

» Click on the various directional displacement values by selecting x, y, z & R (Resultant). Rx, Ry, Rz is

the rotation of joints in radians.

The Maximum and Minimum displacement is shown at the bottom of the screen.

» Click on this legend = an arrow will appear to pinpoint the node of maximum displacement.

2-Building Analysis Model X

o B B I ) e e e

e
= 1?6&;5-0&

‘!
|
\
957F-'p¥ =
I

— | :

i

= -czfgg,,“l —

B=0.01

Displacement [Resultant] - (G) - Max:0.011, Min:2.4312E-04 m /

B=6.8643E-04

N B‘f}?}!}{;ﬂ[-ﬂ«i

—

Deflections shown
inred lines

Click on this legend to
locate max displacement

» Click Animation to visualize the deformation of the structure.

» Switch off the Displacements display and click on the Diagrams button.

» Click on the Axial force N icon to display the Axial Force diagram (for G Load Case).
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1_Model Analytical Model

I= BIM Display Views Help General Members Results Contours Solid Model

N T igdlabels |l Columns Rigid Link
Z y2  Mpp  Auto Scale ji ShearWalls
Diagrams - =
vy Mg Scale 2.5 (7 Beams
Diagrams

3 - Building Analysis Model X

Diagrams Legend

N - Axial forces

V2 —Major shear force of beams and
walls. Shear of column along dir 1

V3 — Minor shear force of beams and
walls. Shear of column along dir 2

M2 — Minor moment of beams and
walls. Moment of column along dir 1

M3 — Major moment of beams and
walls. Moment of column along dir 2

T-Torsion

» Experiment with the various effects of the diagrams.

You can change the diagram scale by de-activating Auto Scale & typing the desired Scale.
You on/off the diagrams on Column, Shear walls, Beams & Rigid link by clicking on the respective icons.

» Click Properties icon reee & select a frame member will show the detailed member properties,
including material, section properties & summary of analysis forces at both members ends.

Frame: 216 Properties X
i‘rame No élé
Structural Member RB8 (Beam)
Nodes -

'\ Rigid Zones v
Restraints v
Material Properties
Section Properties -
» I-Section
\ » J-Section
Temperature Difference v
\ Analysis Results () -

4 I€nd
N - Axial Force 0.00 kN
V2 - Shear Force 2 -25.97kN
V3 - Shear Force 3 0.00 kN
T - Torsional Moment 0.00 kN.m
M22 - Bending Moment 0.00 kN.m
M33 - Bending Moment. -33.41kN.m

4 JEnd
N - Axial Force 0.00 kN

Contours tab will show contour results for shell elements which will only be visible if finite element
shell walls is assumed, or floor slabs are selected to be meshed in Building Analysis.
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» Go to the Solid Model tab.

This allows the various effects such as Axial Load & effects to be color-coded on the physical model.

Contours Solid Model

Review Analysis Design Drawings & Reports BIM Display Views Help

N T E I_z‘ / Frames
ve Mz Lx A, shels

V3 M3 I_Y.
Solid Model

3 - Building Analysis Model X

N
(kN)
-1472.16
-1349.48
-1226.80
-1104.12
-981.44
-858.76
-736.08
-613.40
-490.72
-368.04
-245.36
-122.68
0.00

1IR00C000H.

N

Lo
» Close the Analytical Model view by clicking on the “x” sign next to the view name.

» Alternatively, you can click to switch to plan view and exit the Analytical Model
interface.

You must interrogate the Analytical Model and check its validity as that is the actual analytical model
from which the design forces will be based.
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Column & Wall Design

> Navigate to the Column Section Design under the Design tab.

The columns and walls are not designed as indicated by a red cross under Design Status header.

= B A4 o s Column Reinforcement Design - Project: Quick_Start_Guide_after_analysis A - [m| x
IE = Design Reports [‘
. L N
S % w T Y B O e
Interactive  Column Design Steel Settingsand  Filter Delete User Copy Bars é
Design (Batch Mode) Standardisation Parameters Defined Loads
Design Edit
0
Columns Storey (r:rln) (nk:ri) 25;‘3: ungz;hténn Print Qty SS;DET[";S Steel Bars Links
> GC1 1 500 250 X o 0 0 A
2C1 2 500 250 X o |0 0 ]
3C1 3 500 250 X 0 0 0
RC1 4 500 250 X 0 0 ]
GC2 1 500 250 X 1] 0 0
2c2 2 500 250 x 1] 0 ]
3C2 3 500 250 X 0 0 ] v

%
> Click Column Design (Batch Mode) =

Column Reinforcement Design

Three design options are :

Storey Filter

Process Completed, Check Steel (Select New Steel When Previous Bars
are Insufficient) : Assuming there is previous design,
only change rebars that is insufficient. Bars that are
sufficient will not be changed at all.

Re-select Manually Edited Links

Check Steel (Don’t Select Steel When Previous Bars
Reinforcemnet Selection Options .. L.
Check Steel (Select New Steel When Previous Bars Are Insufficent) Are InSUfﬂCIent) : Freeze a” eXIStlng rebars,
Check Steel (Don't Select Steel When Previous Bars Are Insufficent) insufficient column will be marked as failed.

®) Re-select All Bars

Re-select All Bars : Discard all previous rebars and
i: o | o X redesign all the beams with current beam design
|:Messages | 3 Close settin gs.

» Pick Re-select All Bars to design all columns.

Once batch design is completed, the “Message” icon will appear.
»  Click on Message icon to review the design summary.

If there are any failures, the exact beam & reason will be stated.
» Close the notepad & batch design dialog.

The design menu will be updated with pass status, UR = Utilisation Ratio and other steel bar information.

> Go to the Reports tab = Choose Design Report =)

A tick in the Print column marks the columns included in the report. Columns can be added or removed
from the report by checking or unchecking the Print checkbox. Furthermore, icons Mark All Columns
and Remove Print Marks can be applied to all columns.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Column Design Results
ReportOptions

Indude All Load Combinations in the Report
Indude Interaction Diagram in the Report

Display All Combinations in the Interaction Diagram

| Indude Column/Wall Sections in the Report

v| Indude Detailed Shear Calculations in the Report:

Column Design Report Title:

Column and Wall Design Results Report can be prepared using this dialog.

The report will contain the members as filtered and sorted in the Column/Wall Design Table

v X

OK Cancel

» Check “Include Column/Wall Sections in the Report” to draw the column section detail.
» Check “Include Detailed Shear Calculations in the Report”.
You can also give the report a title.
» Pick OK to generate the report.
All reports can be exported in PDF, MS Word, image, or webpage (HTML) format.

Column Reinforcement Design - O x
M A 10.00% =
) 3 O FitPage Q, | 110.00 = iR @] @] [ Tolmage -
B0y Fit width @, zoomIn
b 100% Ruler POF  ToOffice [, Toweb -
" 0 Mitiple Pages €, Zoom Out [ vesal oomE [ Towed
Zoom Show Export
Notifications a |t

— Lolumn Reinforcement Design

GC1 (A-1) (500/250)
Materials: C30137 / Grade 500 (Type 2) Links: Grade 500 (Type 2))

Section

Critical Loading: 1 - (G+Q)
jn___Design

lf

N 67404 - 674.04 kN
My 2069 1348 2351 kNm
Mz nn 1348 3478 kNm
Nig 303153

Concrete Cover = 35 mm

- Neutral Axis: 174 mm / 11.45¢

= Shear Rebars
- Vexia = 15.19/10.34 kN Slender Column. AS(Reqk  %0.20mm 250 mF
- Vs = 0.13/0.13 Nimm? ALim, = 253z 205 As (Sup). %064 796 mmé
l- Vi = 1.04/1.15 Nimm? Aglimg = 16<205 ¢

Ve v = 570/570 Nmm?  |Masana = 375/000 im  |GHI3
= Links = H10-250

((»IurlmF:mrﬁ:ln:nnm([:tslml race: JEll 1 ‘ D NoEvors () Mowamings () Messages: 0

» Exit & this report will automatically be saved & made available for compilation in Report Manager

The Interactive Column Design allows you to examine & alter individual column designs in more detail.

» Double click on GC1 in the list of columns in the Column Design screen.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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— @| Section Dimension shows the
e e P parameters of the column such as size,
clear height & concrete cover

Shear Desgn | Slendemmess

- = " b Steel Bars shows the number and layout
= [ | Bet—— ) of the rebar. These can be changed.

et e o e : Load Combination table list down all the
load combination. The most critical

(governing) is highlighted in red.

$39.19

$51.85

op 6220

0 0 ) Sotiom 50486
$ T $39.03

o
TREYRTIES

20 0

Required & Supplied As are calculated
from the critical load combination.

55169
145
504.11
292,08
01.%
»n2.62
0199
»1.58
400,95

20 nd
PR ot S a4

AR AE AF 4 6B 65 4B @S A5 5F
44t A4 4N
G LB &5 LB 4B ER 4B B

Slenderness tab shows the bracing
assumption, calculated effective lengths
& additional moments.

seectnseiect Al

If there are changes in the assumption of this column, you can click the Interactive Design button to re-
perform the reinforcement design.

You can change the dimensions (b1, b2) above & click Update. This is handy if a column fails due to
insufficient size & you want to try out if a bigger size works. However, due to the change in column size,
the weight & stiffness of the model will change. Hence, you should re-run the analysis and re-check the
column design to ensure it is sufficient finally.

» Click Column Analysis to inspect the Interaction Diagrams (capacity curves).

The Interaction Diagrams (N-M) show the possible combination of axial force and moment that cause
failure to a given column dimension and rebars. This “capacity curve” indicates the maximum axial
capacity of a reinforced column is dependent on the co-incident or applied moment (vice versa). The
axial capacity of the column decreases as the applied moment increases until the ‘Balance point’, i.e.,
the maximum theoretical moment capacity. After this point, moment capacity decreases with
decreasing applied axial load.

1% Interaction Diagrams - Column: GC1 (Storey: 1) O *

INTERACTION DIAGRAM (N-M) - GCIN= 542.61 kN M22= 19.4 / M33= 28.5 kN.m > Se/ect [nteraction Dl‘agram (N_M)

(500/250 mm) 8H13

For rectangular columns, there will be 2
capacity curves in direction 1 and direction 2
respectively.

The governing design will be the direction with
load combinations closer to the curve; for this
column in will be along dir-2, the shorter
dimension & hence weaker capacity.

» Select Dir-2 (N-M22)

0 To verify that this column passes with the
rebar selected, all the design combination
o e "7 | points must be within the curve, especially if
w [ o] ] wes0/00 nesmes ez | yoy have manually changed the rebars in

a | = /| x Rebar Table.

~elp Report Close

1200
Design Combinations Balance Point \

N (k)
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The Interaction Diagrams (M22-33) plots the component directional moment capacity of the column at
a given applied axial load.

» Close the Interaction Diagram and go to the Slenderness tab.

The Slenderness tab shows the bracing conditions of the column/wall, effective length factors &
additional moment (M-add) due to slenderness.

Steel Bars Links Shear Design Settings

Bracing

/| Dir-2; Braced

+’| Dir-3: Braced

Effective Length Factors

B-2:
B-3:

0.729

0.669

Bracing

Dir-2: Braced

Dir-3: Braced

Effective Length Factors

B-2: 1.792

B-3:

1,442

Edited

Slenderness
A2/himit2 0.176

A3/Adimit3 0.335

Edited

)

DESIGN REPORT
CRITICAL COMBINATION: #1 (G+Q)

Added Moment-22 = @.80 kN.m
Added Moment-33 = .88 kN.m|
N-Design = 524.46 kN

M22-Design = 19.55 kN.m
M33-Design = 28.74 kN.m

Edited

Slenderness
A2/A-imit2 1.229

A3/Aimit3

Edited

——>

DESIGN REPORT
CRITICAL COMBINATION: #13 (G+Q-Ny)

Added Moment-22 = 38.12 kN.m)
Added Moment-23 = 10.36 kN.m|
N-Design = 525.35 kN

M22-Design = 50.89 kN.m
M33-Design = 31.51 kN.m

For this column, it is braced in both directions, the
calculated effective lengths B are less than 1 & hence
M-add is zero or minimal.

You can change the bracing condition manually.
» Untick both Dir-1-Braced & Dir-2 Braced

» Click Interactive Design to refresh the design
>
>

Notice the unbraced condition of the column now
results in effective lengths > 1. As a result the additional
slenderness moment, ‘Added Moment’ is calculated
and auto-added to the base desigh moment to become
the final design moment.

Click Design Report for detail report
Go back to Slenderness tab to review

If you want to manually save either the Bracing or B
factors, ensure to tick “Edited”. This means the design
module will not auto-calculate these values anymore.

» Click Diagrams to view the shear force, bending moment, or deflection diagrams.

» Click Elevation Drawings to view the reinforcement of the column in elevation.

ProtaStructure’

ProtaSteel’
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Manually Specifying Column Design Forces (for info)

The column design forces are automatically linked and updated to the latest analysis run. You can over-
write the column design forces manually.

ol

To manually enter column design forces :

teelBars | Lrks | ShearDesgn | Sendemess | Settngs 1

. Select the first row of column design forces

To select more rows, hold down CTRL key

2. Pick Select Marked Combination as User Defined

L 12 > 3. Click on figures under “N” axial load & enter
sbasdis . 7 ‘ figures for top and bottom, e.g. 1000,1000
. 4. Pick Select / Unselect All to select all rows
. . . 5. Click Interactive Design to refresh the design
6. Untick User Defined Loads to auto-link back to
. - . analysis forces.
A

Manually Change Column Reinforcement (for info)

The column design module will automatically design the column to pass status. However, there are
situations where you might want to specify the reinforcement manually & check if the column passes.

To manually fix the layout & number of rebars & let column design auto-select rebar size:

Column Design
i TR = v X -
B % % ‘EE' [E3 HJ 1. Input “2” for 1-int under Qty column
In[\)era(n‘te thlmm [saveams SRa=.'eS; Rﬁeset Parameters Jma%e EDIe-,anon OK Cancel
esign nalysis Report epor ars ax /Min rawing . . .
4 " Notice diagram now shows 2 nos. internal
E— horizontal bars on both sides
Steel Bars Links Shear Design Slenderness
| 2. Pick Parameters
g:_e\ Qty Area Ratio A(::E;E?
Comer 1 " : 2| 3. Pick Fixed Bar Layout Method = OK
wnt | 24 1 2 . .
e i Mnmsston Hethed ot 0 : o | This option ensures that the number of bars
o ————— will not change during re-design
Clear Bar
2] vl * Required As= 125 mm2 4. C//Ck /nteractive Design to re'deslgn
Help oK Cancel T‘u”‘m:"“ AS: 2521“::1‘,9” 35) = As.min . .
. fem ez GosI=Rmm L The column will be re-designed to 8 number
€30/37  Grade 500 (Type 2) . B of bars as specified. If this reinforcement is
— 17op 6473 MES 3169 insufficient, the program will auto-increase
» * . » -Bottom 677.40 -10.32 -12.98 i
Ll 27wl wss7 A e the bar size, say from H13 to H16.
3 -Top 618.71 20.53 26.32 r T SR I =~

You can also manually change both the number of bars and rebar sizes (i.e., both Qty & Diameter). Do
not click on Interactive Design, which will change the rebar sizes. You must then manually check the
following to ensure the column passes:

» Check As Supplied is more than As required and Min Steel %

» Click Column Analysis = Check all design points are within the Interaction Diagrams N-M22 & N-M33

> Click Cancel to exit the Interactive Column Design dialog and Close the window.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Beam Design

» Go to Design tab = pick Storey Beams U

Page - 64

Since we have selected beam reinforcement design as part of Building Analysis, all the beams are already

designed as indicated by green ticks.

CERE — st Dot
n Report
m— a A =] w R

- = L = A

Interactivel BeamDesign [Diagram  Desgn  Optimize Layers Settngsand  Fiter  CopyBars [
Design || (Batch Mode) Messages (Multiayer Pattern)  Parameters  Axes
Design Edit
Grou A Storey Part Beam Quantity Rebar Pattern

o 1 1 5 1 Standard Pattern 2
Standard Pattern 2
Standard Pattern 2

Standard Pattern 2

1 1 1
1 1 1
a1 1 1 i 1
1 1 1

Standard Pattern 2

e - 0 X
(2]
= m = E_EI_, e} (3 Mark All Design Axes
=) = 22 A B Mark Group Master Axes Only
Summary Summary Detaled  Flange  Barlist Utiization
Table  Report Report Shear Check Ratio Table @ Remove Print Marks
Reports -
Design U. Ratio Print Beams
X 0 GB1-GB2 -GB3 -GB1S - GB19 A
x 0 GB4 - GW1 -GBS
X 0 GBS - GW2 - GB7
X 0 GB8
x [ GB9 - GB 10 v

» Click Beam Design (Batch Mode)

The same 3 options of design which were presented for columns are shown.

» Pick Re-select All Bars to auto design all beams at one go with the current design settings.

» Pick OK when prompted if you want to use the current rebar pattern set in beam design settings.

» After completion of batch beam design, close the batch beam design dialog.

The beam design dialog will be updated showing pass status for all beams. A tick in the Print column
marks the beams included in the report. Beams can be added or removed from the report by checking

or unchecking the Print checkbox.

»  Choose Remove Print Marks to exclude all beams in the report.

»  Checky/tick the checkbox under Print for the first-row beam axis D only.

ey - 0 X
-5 Srouping 2
] i = ==
: =4 0 = : . % : =
Interactve  Beam D Diagr De b Layers Set Fiter CopyBars @ Sur Summary  Deta = thzato . i
0 1 1 5 1 Standard Pattern 2 1 GB1-GB2 - GB3 - GB18 - GB19 o
c 1 1 3 1 Standard Pattern 2 v o

» Choose Summary Report

Summary Report

Report Options

| Print Design Forces Summary
w/| Print Shear Force Diagrams | Print Bending Design Summary
/| Print Moment Diagrams /| Print Shear Design Summary
| Print Rebar Summary

| Print Deflection Summary

Beam Design Results Report can be prepared using this dialog.

The Beam Design Report is in rich text format.

Print Beam Loads — List all the loads on the
beams in table format. This will significantly
increase the size of the report.

Print Shear / Moment Diagrams - Print the
envelope shear / moment diagrams in pictures.

Print Rebar and Axis Image — Prints
reinforcement design as shown in interactive
Reinforcement Data interface. This will
significantlv increase the size of the report.

Select\Deselect All
Report will incude only the filtered beam axes in the Beam Design Table.
v X
oK Cancel
A
ProtaStructure’  ProtaSteel
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» Uncheck Print Beam Loads (for faster generation of report)

» Pick OK to generate the report.

Prota Scoftware Asia (21838)

Beam Reinforcement Design

Beam Reinforcement Design
Eurocode 2 (SG)

(EN 1992) Design of Concrete Structures (Singapore Annex)

Shear Diagram (Envelope )

Notation Definitions
foe Compressive (Cylinder) Strength of Concrete
fye Yield Strength of Longitudinal Reinforcement
Fymi Yield Strength of Transverse Reinforcement
E. Modulus of Elasticity of Reinforcement
bw Web Width
h Depth
d Effective Depth
Co-comprassion | Compression Reinforcement Clear Cover
Co-tengon Tension Reinforcement Clear Cover
. Compression Reinforcement Cover
Cension Tension Reinforcement Cover
Ag Gross Cross Section Area
Axis : A
Analysis Results

wl
7230 5758

GB1 G2
L=5.00 m) L=5.00 g

Page - 65

> Exit & this report will automatically be saved & made available for compilation in Report Manager

» Click Detailed Report = uncheck all options for faster generation 2 OK

The report recreated has more detail containing clause by clause check, example below.

Rectangular Section Details ( Top Section )

Design Bending Moment

Depth

Maximum Allowable Depth tothe Neutral Axis
Equivalent Rectangular Compression Block Depth

Required Area of Tension Reinforcement
Minimum Area of Tension Reinforcement

Maximum Area of Tension Reinforcement

bw h Ag= beh |d Cocompression | € o tension Ccomprassion Ctansion

(mm) (mm) (m?) (mm) (mm) (mm) (mm) (mm)

250 500 0.1250 449 35 35 52 52
Bending Design ( Top Section )

Limiting Value of the Ratio of the Neutral Axis Depth to the Effective

Maximum Distance from Extreme Compression Fiber to Neutral Axis

Mzs = 61.5 kN.m ( Negative Moment ) — Tension steel will be
placed at the top of the section.

(x/d)m = (8-ki)/ ke = 0.5(Eurocode 2 (SG) 55.4)) —
fa=50.00 N/mm?

Xmx = (x/d)mad = 202 mm

amx = Axmx = 161 mm

a=d-V(d2-2Meq/ (nfabe) ) = 34 mm

a < amox — Tension-controlled section. Compression
reinforcement is not required.

As = Meg/ (fa(d-a/2)) = 327 mm2

Asmn = Max [0.26 fum/fy, 0.0013]bwd = 169 mm? (Eurocode 2

(SG) 9.1N)
Asror = 0.04 Ag = 5000 mm? ( Eurocode 2 (SG) 9.2.1.1(3))

ProtaStructure’

ProtaSteel’
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Page - 66
» Double click on any of the beam axis in the list of beams in the Beam Design dialog.
The Interactive Beam Design allows you to examine individual beam design in more detail.
T - Reinforcement Data - Axis: A
Beams Rebars
A < Previous Span ) Copy Bars
=t =] w8 =) B v X
B NextSpan (4, Paste Bars =
Select Diagrams Detail Beam Design Not Scaled - 3 Summary Detailed oK Cancel
Bars - Drawings Parameters Span | 3500 ¢ ([ vPesteBarstoAl  peport Report
Copy/Paste Reports Exit
Standard Pattern 2 s 2 3
1 ' et < \ B2 < . |ee3 <
327 102 327 342 150 342 1237 385 1235
SO SsoRie) Gfl 212 249 224 Glcl 181 181 181 1 491 393 490
' 250x500 ‘ ' 250x500 ' 250x600
! : :
. 500 4500 | 500 4500 , 500 7686
b i ¢ ‘ t i
9 2071 1176 74
Extra As(mm2) 2 I ‘ 186 149 174 | I 40 4
As-min (Top) 3 169 169 169 169 169 165 203 207 203
As-min (Bot) 169 169 169 169 169 169 207 207 207
s-Bar-CL (Top) 4 <74> <74> <74> <74> <74> <64 > <64> <74> <128 >
s-Bar-CL (Bot) <74 > <74> <74> <74 > <74 > <49 > <49 > <74 > <49 >
Deflection Check 5 Ld=11.15 < 121.71 /d =11.15 < 233.34 Jd = 14.38 < 56.5
x-Sup. Links 1125 1125 1125 1125 1922 1922
Links ) 1H10-300 1H10-300  1H10-300 1H10-300  1H10-300  1H10-300 1H10-150  1H10-150  1H10-150
Top Bar 3U13 = L 3H13 ' 13 _.
Support Top Bar 1 3H13 3H32 ]
< Support Top Bar 2 > 7
Bottom Bar 1 3H13 - 3H13 — 3H13 ]
Bottom Bar 2
Support Bottom Bar 1H13 _ 1H13 ___1H1
\_Veb Bar J Els

Reinforcement Data window shows the details of the beam design :

1. Required As is shown in blue as is based on design envelope of all load combination.

Extra As shows the additional or surplus area of steel based on selected steel.
As-min (Top & Bottom) is calculated minimum area of steel.
s-Bar-CL (Top)/(Bot) shows the spacing of the rebars at the outmost layer.

uehwnn

automatically applied.
x-Sup. Links shows the distance of the support region for links

o

Deflection Check shows the actual vs allowable span/effective depth. The modification factor is

7. Rebars designed are shown in the various rows including shear links, main bars & web/side bars.

These can be manually changed if desired.

Any figures in red indicate a failure to meet the design criteria and should be investigated.

» Click on the Beams tab at the top right corner.

This shows the summary of the beams parameters along this design axis including a 3D view.

f,( T - o x
] ' (lf‘ v X
- Concrete: C30/37 - Fck = 30 - Fd = 20 (N/mm2) Beam
Steel: Grade S00 (Type 2) - Fyk = 500 - Fyd = 434.78 (N/mm2) Beam Axs A 1
f o o= -:‘:’.‘”I i
ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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» Go back to Rebars tab = Click on the Diagrams button to see the loading and design forces.

> Beam Design Diagram

Beam Axis

6(77

/| Display Detaled Values ie 2 anv . g%%l A 5 s7hs 708
/| Optimize Stations 1] 36 % S
28

segeTaeance: | 20%] oz g A Display Detailed 11 W

1 I
— W Values ot W W
72.30 -67.88 abe B3 o o

N viv2 v3 ame ID 8¢ 84.39

T | M33 m22
52 a3 Loads. Di Distance :" 5 e

ﬁ oaas, |agrams NAN  an 2089

& Deflections

a 6.76 6.776 2
S~ | |T< g = 0.000  0.000 -101.7 8116.0
7.7, gaq

e \":\“ AR 52(Ma 000 0.000 16y Ty jiﬁfa'i 434
Load Cases & Combinations M33 (kN.m) - - - - D,

- | T - = I Ry =
‘ﬂ;l y EES T : L
Eocse dagan 472 46 S g0 5681 574 26.7 ﬂl(:

Deflection Display Type:

&2 Qe L02DS _Ca;es &
a2 Combinations

NQ 52 ’ 9.2326F-04

Y m) T = — — —

GQ 0001 000 Y —,éo P ,., )»L\Fd@sm B AAT9E-04 E v
20008 (

G+Qp2 0.01378,013 0

G+Qp3 0.020 ™o 020

G+Q+NX 0 O?B(gé{i.ﬁ“‘*? i

&1 - a5 6 71 b
GHx+Q Frame ID 6 62 85, 67, 89 T4 73

75, T TS 53 58
G+QNy 66 88 70 72 /4 76 78 80

GB1 GB2 GB3 GB18 GB19
G+Qly L=5.00 (m) L=5.00 (m) L=7.888 (m) L=5.00 (m) L=5.00 (m)

| Ea[x] . - Visualization >

‘Show Magnined Seismic Design Results Tools

& X

Report Exit

Loads, Diagrams & Deflections

R0

< Display Detailed Values:

e Checked: A tracing window will appear showing the exact values of the diagrams, e.g., shear &
moment, when the mouse cursor is placed at a particular location on the member.

R

< Optimize Stations:
e Unchecked: The diagrams are displayed using the default maximum number of stations.
e Checked: The number of stations will be reduced & optimized to maintain similar accuracy.
« Diagrams:
e L1/L2/L3: Checkto show slab loads decomposed & user-defined loads on beams.
e N = Axial force ; T = Torsion
e V2 =major shear ; M33 = major moment ; 62 = major deflection
e V3 =minor shear; M22 = minor moment ; §3 = minor deflection
« Deflection Display Types :
Deflections are calculated along the member span for each load case and combination. Deflections can

be displayed in three different ways:

e Absolute: The absolute rotation and deflection values display the deflected shape.

¢ Normalized: The absolute shape is normalized to the value calculated at the first point.

e Relative: The deflected shape is normalized to both start and endpoints. This is particularly
useful in determining the deflection relative to both ends in serviceability checks.

Visualization Tools & Report

< Horizontal Scale W 3> Increase or decrease horizontal Scale of diagrams.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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«» Default Display Scale E - click to reset to the default scale.

< Increase / decrease font size —
«» Default Font Size Al -> Click to rest to default font size.

% Report %! - Generate a report in tabular format with/without diagrams.

» Exit the diagrams & Close the beam design dialog

The same beam diagrams can be assessed by :
> Select a beam on plan view =2 Right-click = Analysis Results Diagram
The same diagrams are used for columns & walls :

» Select a column or wall on plan view 2 Right-click = Analysis Results Diagram

B
> Alternatively, access the Interactive Column Design = pick ‘Diagrams’ =~

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Slab Analysis & Design

For beam/slab models, slab reinforcement can be obtained by inserting slab strips in the X and Y
directions. This process uses the moment coefficient method of selected code. This is independent of

Page - 69

the general building analysis and can be carried out before or after the building analysis.

To use the moment coefficient method, it is essential to set all the Slab Types correctly per the provisions
of selected code. This can be done automatically in batch mode by right-clicking on the slab icon in the

structure tree and choosing Set Slab Types Automatically.

» From the Structure Tree, double click on storey St: 1 to return to the 1° Storey plan view.

» Right-click on Slab - Set Slab Types Automatically > Choose defaults options 2 OK

4 € Storeys
» © St: 0( +-0.00m)
4 © St:1(+3.00m, Sim:2,3)

» |' Columns

» [ ShearWalls

» (7 Beams

| X
<7 Ribbed Slabs | 23 Slab Table
& Slab Strips L. Slab Analysis and Design
X Braces k2= Slab DeflectionCrack Check
< Trusses
£t purlins == Slab Reverse Deflection Table
-~ Girts Set Slab Types Automatically

P Bl -

B, Messages

Unspecified Slabs:
GS3
GS10 (Edge Count> 4)

Spedified Slabs:
Gs4 (Type=7)
GS5 (Type=4)
GS6 (Type=7)
GS7 (Type=7)
GS8 (Type=4)
GS9 (Type=7)

Total Number of Slabs at the Storey=8 A
Count of total slab hole in storey=0

m} X

<
)

Slabs that do not have 4 edges is beyond the scope of the moment coefficient method. It will be
entirely up the user to set the appropriate slab type or use alternative finite element method to

analyse & design these slabs.

» Click OK to close the Messages dialog.

» Go to the Modelling tab & click on the Slab Strip

The Slab Strip Properties will be displayed:

e Slab Strip Type: Analytical Strip is used for design based on the Code Method. FE Strip is used for
innovation based on Finite Element Analysis results. Manual strip is used to manually input rebars

without any analysis & design.

e The correct “At Start” and “At End” boundary conditions must be
specified when drawing the strips. The three options are:

=+ Slab - The Strip starts or ends inside a slab. The bottom steel
for the slab in question is not designed, but the span of the slab
can be defined, and this value is used in determining the support

steel extension.

= Bob - The Strip starts or ends beyond an edge beam or wall.

The support steel at the edge is bent down into the beam/wall.

== Cantilever - The Strip starts or ends beyond a cantilever slab.

ProtaStructure® ProtaSteel

Slab Strip
General FE

X1 Dir: |2 X Y

No: | 1

<>

Type: | Analytical Strip | v

Boundry Conditions
[ —

| E— :I-
| | | s— ] —
= I T

AtEnd: == | = |7=

At Start:

ProtaDetails’
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» Set the Dir: to X Slab Strip .
> Set the No: to ‘1’ so that the strip label is X1 [ General [ E |
» Set Type to Analytical Strip ' - o @T '
> Set the At Start condition to Bob. No: | 1|8
» Set also the At End condition to Bob.
Type: | Analytical Strip | v
Pick the slab strip’s start point outside the floor plan, as shown below.
—Boundry Conditions

» Hold down on the CTRL key and then click the end of the strip to the right atstart: ===~

of Axis 4 | AtEnd: === |

O

» Draw another similar slab strip X2 to obtain the design for the slabs between Axis B-C/1-2
» Draw similar slab strip X3 to obtain the design for the slabs between Axis B-C/3-4
» Draw slab strip X4 to obtain the design for the slabs between Axis C-D/1-4

——®
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Now draw the vertical strips to design Y-direction rebar for the slabs. Skab Strip .

» Change the Dir to 'Y [ General
» Reset the No: to 1 again so that the strip label is Y1
» Keep Type as Analytical Strip No:

» Keep the At Start condition as Bob
Type: | Analytical Strip | v
» Also, keep the At End condition as Bob

Boundry Conditions
» Draw 4 nos. of the vertical strip through all of the slabs atstart: (2=

The final layout of strips & slab reinforcements should be as shown below. AtEnd: == T—

F
]

We can now re-check the strips as a batch and create a slab analysis & design report.

» Go to the Design tab - choose Slab Analysis and Design

E s Slab Analysis and Design m - 0 X
Design
v = ;
-, E,EE% = T? E [ Paste Bars E [ Mark All Siab Strips
Interactive Slab StripDesign ~ Settingsand  Filter  Copy Bars [, Paste Bars to Al Design @ Remove Print Marks
Design (Batch Mode) Parameters Report
Design Edit ~
Slab Strip Storey Type Analysis Results Source | Slabs U. Ratio Design Status ‘ Print Rebars
G52 (h=200 mm) - 16H10-300 + 19H10-250
X1 1 Span Strip - GS3 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS1 (h=200 mm) 16H10-300 + 20H10-250 + 14H10-250
X2 1 Span Strip - GS4 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
X3 1 Span Strip - GS5 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
G56 (h=200 mm) 11H10-300 + 13H10-250
X4 1 Span Strip - GS7 (h=200 mm) 0.0 v z 16H10-300 + 19H10-250
G58 (h=200 mm) 16H10-300 + 19H10-250 + 19H10-250
G52 (h=200 mm) 16H10-300 + 19H10-250
Y1 1 Span Strip - G54 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS6 (h=200 mm) 13H10-300 + 18H10-250 + 10H10-250
Y2 1 Span Strip - GS3 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250 + 19H10-250
Y3 1 Span Strip - GS7 (h=200 mm) 0.0 v Vv 16H10-300 + 19H10-250 + 19H10-250
GS51 (h=200 mm) o 14H10-300 + 14H10-250
¥4 1 Span Strip . GS5 (h=200 mm) 0.0 v v 16H10-300 + 19H10-250
GS8 (h=200 mm) 16H10-300 + 19H10-250 + 19H10-250
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The slab analysis & design dialog will appear with a summary of pass / fail status, utilization ratio &
reinforcement. The functions at the top menu bar are :

% Interactive Design: Select a slab strip = Interactive Design will allow access to detail strip design

< Slab Strip Design (Batch Mode): Redesign or re-check the existing design of all strips at once

«» Settings & Parameter: Opens up the slab design settings in the Settings Center

< Filter: Allows filter by a storey, slab thickness, and design status

«» Copy Bars & Paste Bars: Allow copy & paste of bars of similar slabs marked with = symbol
« Design Report: Prints out the design report

> Click Design Report

The Slab Reinforcement Design report will be displayed. Options are available to configure and then
print it. Any failure in the design will be highlighted in the Notifications pane at the left.

slab Analysis and Design - 0O x
S .00% . X
Eﬂ |—\-) > FitPage Q [10.00 ¥ G Horizontal Ruler @ @ [ Tolmage -
= Bl 1y Fit Width @ zoomIn
P 0% e poges @ Zoamut 3 Vertical Ruler POF ToOffce [ Towed~
zoom Show Export
Notifications 2| I a2 s B B 1T B i e 10 Tl e T3t 0 6 1T 1181 118 4 12 "

Notifications  Headings

© Gs2:5upplied Reinforcement is Sufficent - Slab Analysis and Design
© Gs3:5upplied Reinforcement is Sufficient

- Notation Definitions

© cst:supplied Reinforcement is Sufficent - d lab's Efiective Depth
h lab Total Depth

© Gs4:5upplied Reinforcement is Sufficient . gmax ximum Load Combination

- L idth of the Siab Along the Stip Direction
© Gss:Suppied Reinforcement is Sufficient - M th o the Slab Pependicular 1o the S Direction
© Gsé:Suppied Reinforcement s Sufficent ; et f,"nf;c:“‘ C=M/(p12))
@ Gs7:Suppiied Reinforcement is Sufficient o As Area

© Gs8:5upplied Reinforcement is Sufficient -
- Slab Strip : X1 -- Storey : 1

© Gs2:Suppled Reinforcement is Sufficient

© Gs4:5upplied Reinforcement is Suffident = Materials : C30/37/Grade 500 (Type 2)
@ Gs6:Supplied Reinforcement is Sufficent = -
: dih qmax L, | Support] Span [ e Asleft | AsSpan | AsRight | | | soanpam | Right
@ Gs3:Supplied Reinforcement is Sufficient = sap | mm max L| ° C | Let | Requied | Requied | Requied o oy | “pongiy | Suppot
- Angle | Combination = M M Right | Provided | Provided Provided Straight Straight Straight
© G57:Suppied Reinforcement s Sufficient s C) | kNm) GNom) | GNm)| Nm) | Gomd) | () | (o) < < <
= G2
© GS1:Suppied Reinforcement is Sufficient - 5200|1287 | 500 | 00450 [000| 15 2%9 29 A9 | HIOB0 | oo | HIG2SO
N 0 136150\ 4| B1 |89 | @1 | e u9 B @ | MR Tm
@ G55:5upplied Reinforcement is Sufficient -
- G
© GSa:Suppied Reinforcement is Suffcient 2 %65200| 1287|5000 | 00450 [00340| 131 2%9 29 A9 | HIOB0 | oo | HIG2S0
0 [1386-150| 4| 31 | 99 | 15 | e u9 M ™) e ™
5200 1287|4331 | 001 |001| 115 | 249 29 A9 | HIOZO | oo | HIG20
0 |1356-150|4273| 80 | 61 | 08 e u9 34 ™) o ™)

Deflection Check

A0 1 e f60 1 150 180 gt
o
4

Slab Ud Udtssimem |5 Status v

Slab Analysis and Design | rage: [l 12 ‘ D NoErors @) NoWarmings () Messages: 16

> Review the report and then Exit
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Design Status
The design status can be displayed graphically in the plan or 3D window.
» Click on the 3D view to make it active

» Go to Review Tab —> pick Design Status —> OK

Analysis Design Drawings & Reports BIM Display Views

Help
€ — 988l = .
] H - | 111 g0 @?\ F})
S g o : B H s« A =11
Fix the Purge  Refresh Connectivity Visual Design | Column Beam Sections Materials Beam Wal Slab Additional
xes Almost-Orthogonal Axes  Sections Information Interrogation | Status | sections Types Loads

Visual Interrogation
rey: 1 (Plan; Storey: 1(30) X

Design Status

. Fail

D Warning

D Expired Analysis
B o«

D Not Designed
. Do not design
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Quantity Extraction Tables

The concrete and Formwork quantity reports can be produced.

» Go to the Drawings & Reports tab = Pick Quantity Extraction Tables
» Choose Concrete Quantity Extractions Table = click Calculate

As shown below, this produces a concrete quantity report with member type and storey breakdown.

Quantity Extraction Tables Quantity Tables
Storey Beam Column Slab Rib Slab Blocks
Concrete Quantity Table

Foundations

Foundation 0.00 571 0.00 0.00 0.00 0.00
Formwork Quantity Table 1 10.76 15.56 32.69 0.00 0.00 0.00
2 10.76 15.56 32.69 0.00 0.00 0.00
Steel Quantity Table 3 10.76 15.56 3269 0.00 0.00 0.00
4 10.76 15.56 37.20 0.00 0.00 0.00
Sheeting Quantity Table Total 43.03 67.96 135.27 0.00 0.00 0.00

Shear Stud Quantity Table

l'.‘
Help F1

Total Concrete: 246.25 m3

> Click Report to produce a detailed report

Project Preferences

The Project Preferences dialog allows you to enter the details of the project model.

» Go to Building Setout tab = Click on Settings Center = Project Preferences = Header

Options

» 0 ProtaStructure Environment

Licence: Prota Asia (21838)

= Consultant
» 3 ProtaDetails Environment Calculated by: #designed_by
— Controlled by: #checked_by
4 "= Project Preferences Drawn by: #drawn_by
{Title Presented by: #presented_by
Statistics Project
Notes Client Name: #dient_name
@0 Unit and Format Project Title: #project_title
> E]: Label Project No: #project_no
=) Codes Project Date: #date
» [Z) Nationally Determined Paramet... Project Address: #project_address
3H Lateral Loading Revision No: Frev_no 1
[ Lateral Drift & Bracing Block Parcel: #project_blockParsel

Title - Enter the Consultant and Project details to be displayed in the header of all the reports.

Close

Statistics - Show graphical chart of essential model information such as the total number of members,
member types, grids & storeys. In addition, it shows the number and types of foundation, beam &
column end releases. A text file can be created.

Notes - Enter additional information on this model, such as revision changes, etc.

» Key in the various information in the Title tab as desired

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"



(3 PROTAETENE page-75

Report Manager

The Report Manager is the central report manager where all analysis and design reports can be accessed
and managed.

= 8
» Go to the Drawings & Reports tab = choose Report Manager =
= Report Manager (Ed ] x
- = - =t >
Current Set: Ir ] ) New [3.. Add All Available @ - + Expand Al [!]'t' ] Load Logo
Default v [ Add al =% p RD I
View = Del . New Report - I | Use QR
» ] Delete [ Remove Al ==l Collapse Al e X Clear Logo
Report Sets Reports Header Settings
== 4 Model Information
Default | == 1T 1 x 2 Notifications QLD & »
Pre-analysis Checks Quick_Start_Guide_Complete-...
Beam Loads Beam Loads Quick_Start_Guide_Complete-... || 4 Post-analysis Checks
) _ Warning: Dir 4... Effective Mass Ratio is less than
Slab Additional Dead Loads Quick_Start_Guide_Complete-... 0 90%. Number of effective modes should be increased
Beam Wall Loads Quidk_Start_Guide_Complete-... and analysis must be repeated.
Analysis Model Echo Report e e— o (B2) Irregularity Check is not performed. !
@ Overturning Check: Dir 1... Mp1 /Mal = 61850.3 /
Storey Displacements } Column/Wall Design Reports 751.2 = 82.3408 =2 2.0 OK
. " Overturning Check: Dir 2.... Mp2 /Ma2 = 61055.5/
Axial Load Comparison Report ) Beam Design Reports ) i) ol el
Report Sets R Reports Repository e
’ SR Notifications
Beam Quantity Report » Foundation Design Reports
» Quantity Take-off Reports
» Building Assessment Reports
» Other Structure Components

Reports Ready: 11/50

e Report Sets (left): This shows the constituent reports, which will be complied & combined into a
single final report.

e Reports Repository (middle): All the individual reports generated and available to be included as a
Report Set.

¢ Notifications (right): Important notes and warnings from the model’s analysis are shown for easy
reference.

You can expand or collapse the main folder by clicking on topic icons. To create a combined report:

| New
> Select New *~ ' inthe Report Sets tab and give the new report set a name.

» Select Add All Available Ce. reports in the Reports window to include only available and generated
reports in the report repository.

Alternatively, click and drag a report from the Reports Repository into the report Sets pane.

» Choose to insert Table of Contents =
tab.

and Summary Report i= using icons below the report Sets

» Select View & to generate and view the report set.

Other useful functions include loading of company logo : Load Logo !, inserting QR Code o & inserting

external .doc or .rtf files : New Report from File LE}

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Steel Model

We will now start a new steel model. This section will cover steel members, trusses modelling, analysis
& design. The below is the screenshot of the completed model, which can also be found in the default
Project Data folder.

’_h*.q./.’ A“\
ST IR

\
\/
IXI
X/
‘/Q
J

[}

N\
AV/A\\/
- \\\7\
Ny
N

U
TR\
UN\W
NN

)
N

» Click New Project " and type the project name as shown using the *_’ character for spaces.

New Project

Project Code: |Quick_Start_Steel
(Available Characters: A-Z, a-z, 0-9,
Templates
Search....
EE Malaysia (BS Code) A
Malaysia (EuroCode, EC8-DCL)
Malaysia (EuroCode, EC8-DCM)

RN ]

Malaysia (EuroCode)
Peru (NTE)
Philippines (NSCP)

Poland (EuroCode)

Singapore (CP&5)

Singapore (EuroCode)

South Africa (BS Code)

South Africa (EuroCode)

== Thailand (US Code, DPT)

& Turkey (TS500, TBEC2018) v

Wi

® Templates: Projects x

(7 | 4 b 4

Help OK Cancel

» Select Singapore (Eurocode) template and then OK
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Axis Creating & Storey Insertion

» Go to Modelling tab =2 Pick Orthogonal Axis Generator in the Modelling tab.

» Pick the intersection of the primary grid near the origin (5000,5000 coordinate).

» In Orthogonal Axis Generator, change Dir-2 Axis Spacing to 5000*2 & click OK.

Orthogonal Axis Generator

GridInsertion

Dir-1 Axes

Dir-2 Axes
Axis Label:
Axis Spading(s

Axis Extension Length:

Reference Point - x:

Insertion Angle:

Axis Label:
Axis Spading(s):

Axis Extension Length:

5000 mm -y
0.0°

A Step:
5000*3

2000 mm
1 Step:
5000%2|

2000 mm

Axis Spacings. You can delimit values with comma character if unequal spadings used. | A
Repeating spacings may be entered using '* as multiplier, provided that spacing to be
written before number of spans. (Ex: 5000, 2000*3,4000)

(2) v

Help F1 oK

5000 mm

Cancel

4 H structure
b =11 Axis

4 = Views

Te | Storey: 1 (Plan)

= Reports
Detail Previews

A€

Right-click on Storeys in the Structure Tree and pick Add new Storey.

b o St:0(+g EE SelectStorey

4 0 St1(+3|E" Insert Storey

) Columes B€ Generate Storey

- [ Ry

Page - 77

Input Storey No.: =2 2 OK. Leave Add Intermediate Story and Generate Members from Selected

Storey unchecked.
Add Storey
Storey No.: 2

Add Intermediate Storey

Generate Members from Selected Storey

A storey number greater than the top storey will add storeys above.

Inserted Storey Height:

3000 mm

Entering the number of an existing storey will insert a storey by shifting the selected one.
When the 'Add Intermediate Storey' is checked, then the selected storey height will be

sub-divided in two storeys.

a

Help F1

v X

OK Cancel

When prompted to confirm =2 Pick Yes = The plan view will now change focus to Storey 2

ProtaStructure’

ProtaSteel’
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Materials & Load Case / Combination Generator

» Go to Analysis tab = Building Analysis - Pre-Analysis tab.

> Pick Edit Materials = Change the steel grade of all members to S355 (as shown below)

= Material

Default Materials
Foundation Floor

Composite Slabs
Ribbed Slabs
RC Staircases

Links

Steel Columns

Steel Beams

Primary Composite Beams
Secondary Composite Beams
Trusses

Puriins

Girts

Braces

Studs

Sheetings

Storey Having Different & 4 Formwork
Material

Timnhae Erama Maoshace £a4am

The global materials grade of the truss, purlins, girts & brace members are shown & can be changed.

Page - 78

Steel

General
Material Name
Material Color
Mechanical Properties
Moduius of Elasticity
Shear Moduus
Possson's Rato
‘Thermal Expansion Coeff
Unit Weight
Design Parameters

Mnimum Yield Strength

Material Coeff

Standard (Norm

I./ #Apply to al members of this matenial class in this storey! I

v

oK

K cancel

Individual member material can also be changed in their respective Section Manager dialog by selecting

the member - Right-click = Edit Section / Material.

We will now auto-generate the load cases and combination (required to add roof purlins loads).

» Pick Loading Cases and Combinations to access the Load Combination Editor.

ad Combination Editor
ULS_RC ID | Label LLRed | ¥OM |T... | Load Combinations
ULS_Steel
515 _RC
515 Steel
Loading Load Cases g 7 & MNumber of Combinations: 12 v X
EriarlE Add Delete Edit Apply P-Delta Analysis oK Cancel
» Pick Loading Generator to access the Automatic Loading Editor.
ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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» In the Automatic Loading Editor, pick the options as shown below =2 click OK.

Automatic Loading Editor

Use Cracked Sections in All Vertical Load Combinations As Well

|| Generate Combinations for Steel Members

V.Load Case = 5

H.Load Case = 4

Add Notional Loads Combinations for Geometric Imperfections

Vertical Load Combinations | Horizontal Load Combinations *Vtrhca\ Load Combinations | Horizontal Load Combinations

Motional Load Factors:  G: 1.0 Q¢ 0.3

| Define Dead Load Case (G)

| Define Live Load Case (Q)

| Define Pattern Loads Automatically

Direction Dependent Pattern Loading

| Define Combinations for Roof Live Load (Qr):

W
v == == = =

v/, Notional Loading

Accessible Roofs  y0: 0.7

NGx, NQx, NGy, NQy

Define Combinations for Snow Load (5):

Define Combinations for Rain Load (R):

Snow Load  wi: 0.7

» Load cases & combinations will be generated. Pick OK & Close the building analysis menu.

Steel Columns Creation

» Click on Steel Column U] in the Modelling tab.

Column x

Gen Geo
Label: x1]8
]
il bi:
T b2:
™ >
[ el 0 mm
{:b e2 0 mm
Top: >
Bot: A 1
Bot Insertion Point: 'p
Angle: 90.0°%)
poir: |12 1 | 2 >
End Releases
N V2 v3 T M2 M3
I 7
3 2
+ Update ¥ Close
ProtaStructure’

In Column Properties, change Len (Storey) to 2

This means the column will span 2 storeys with effective length of
2 storey height. Thus, we do not need to model any column in
STO1.

Change the Angle of rotation to 90 degrees.

This will rotate the steel section 90 degrees on plan view.

Pick Section Manager icon I

This will launch the Section Manager dialog which allows us to pick
a section profile.

_ Column End Condition: Columns ends are fixed by default. You
can apply hinges to top and/or bottom by clicking successively on
this icon.

ProtaSteel’ ProtaDetails’ ProtaBIM"
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Column Steel (UC 300x200x93)

poisbese | Protec > In Section Manager dialog, pick Singapore.
H B1 M

— =a T I This will access to Singapore Steel Profiles

175 44 44 52 50 (Continental)

[Jee - Ea e e )

300 150 25 32 37 41 46 > Pick UB 250x250x67 - Select.

6

IUB 20 48 6 57 65 77 » Pick OK to close the dialog.

I uc 87 106 125 130 147

» Enter eight nos of columns along Axis 1/A-D & 3/A-D

v Storey: 2(3D0) X

(v)

-
|
|
|
|
|

|
|
[

A

Q)

» Right-click on Views in the Structure Tree and pick 3D Physical Model.

4 H structure
b oIl Axes
Y1
[8] Storey: 2 [E Plan

= Reports @ 3D Physical Model
Detail Previews
I\ Connections

4 [F€ Storeys

3D Rebar Model

This command will create a separate window showing the 3D view.

» Go to Views tab —> Tile Vertical

This command will arrange the 3D view and plan view in 2 windows.

» Click on the Plan view to make it active (the active view title & border will be darker)

» Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Column

il ’ <y
Len (Storey): P )
o en ' ' g
@ e 0mm ;// ; / —
’ ()
} (¢ / / /
Bot: | B 2 i X
Bot Insertion Point: 'S . z @)
5

Dir: | 12 1 2

End Releases
2 V3 T M2 M3 73

[ | ®

« Update ¥ Close

Y

Click on the Steel Column icon

A\

Change Len (Storey) to 1 in Column Properties

This property means that the column will only span a single storey.
The columns with “Len = 2” are grey in STO1 because they were inserted in STO2.

Ensure the angle of rotation is 90 degrees.

Pick Section Manager icon I

Ensure that the same UB 250x250x67 is selected.

YV V V VYV

Insert three nos. of the column along GL2/B to D.

Check the 3D view to ensure the columns were properly.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Steel Beams Creation

>

>

Page - 82

Click on the 3D view to make it active (the active view title & border will be darker)

Double-click on Storey 1 in the Structure Tree to switch focus to Storey 1.

Notice the grids will move to storey 1. This operation ensures beams to be created in St: 1 in the 3D

view.

Click on Frame icon #

Then select Steel Beam ¥ ““*"

» Click on Section Manager L inBeam Properties

Beam Steel (UB 250x250x67)

Database Project

EE spyGapore | |v

A
D SHS

UB 250x125x25

H B1
FEsoT assT e 2

300

175
250
150

200

M

44
67
25
69
48

44
98
2

56

29
52

37

57

30
59

41

65

46

77

» End Releases: Click successively to hinge both ends of the beam 1

» In Section Manager dialog, pick Singapore flag.
This will access to Singapore Steel Profiles
(Continental)

» Pick UB 250x125x25 > Select.

» Pick OK to close the dialog.

End Releases

N V2 V3 T M2 M3
I A4
v

b 3
o«

» Click on the 3D view to make it active > Double-click on St: 1 to make it the active storey.

» Inthe 3D view, create seven nos. of beams in the region bounded by GL B, D,2 & 3 (as shown below)

&3
' S

k
I
‘5'
\
|

o

oo
I SR

110 e 22

»)
\ (»)

» Go to the plan view of STO1 2 Create four nos. of UB 200x150x30 secondary beams in the region

bounded by GL B, D,2 & 3 (as shown below)

» Ensure both ends of the beams are hinged

End Releases: | »

ProtaStructure® ProtaSteel’
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Use smart points
0.67 to create these beams|,

@0.33&

Use smart points to create secondary beam. With beam properties out, place the mouse cursor at the edge
of the primary beam (not center) & the smart points will appear at 0.25L, 0.33L, 0.5L & 0.75L.

9
o

Use Beams Sections W in the Review tab to show beams of different sizes by colour. Assign colours to
members in Section Manager dialog > Material Colour

Steel Truss Creation

We will now insert roof trusses. Trusses are best inserted using the 3D view.

» Go to the 3D view = Double-click on St: 2 in Structure Tree to make it active & grids are at St: 2

» Click on the Truss icon r’-'&

ProtaStructure’

ProtaSteel’

»  Pick grid intersections A/1 to define the start of

the truss.

A dynamic rubber band will appear with the
default truss type if no truss is defined before.

» Pick grid intersections A/3 to define the end of

the truss.

After you pick the second point, the truss
generator dialog will appear.

ProtaDetails’

ProtaBIM’
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.
General Sphces Members
) # ;4 =] PPN
N et -
B X d = & X vX
Import  User Defined Load From Wre Frame Shrinked Reset oK Cancel
Truss Types Patterns Label: m[E

A W |l | AN /NN N i i | e

Divide Cross Diagonal Frames

Right Vertical Offset R 0mm
Left Cantiever Length o 0 mm

Madel Joints as Fixed

Enter Left Eave Angle By A
Left Eave Heght H

Enter Right Eave Angle By

Right Eave Heght R

» In Geometry, pick Duo-Pitched truss = Change Truss Support Placement to Top Chord.
» Change Apex Height to 1500 mm, Left & Right Eaves Height to 800 mm.
» Click on the Members tab

& Truss Generato
General Splices Members
E
AX @ = v X
Reset  Delete Wire Frame Shrinked  Reset OK  Cancel
Members View
View
4 Top Chord Top Center () N V2 V3 T M2 M33 () N V2 V3 T M22 M33
12 RHS 150x75x3 Top Center 0 I O N | O oOoooo g
13 RHS 150x75%3 Top Center O O ]
4+ Bottom Chord Bottom Center M N V2 v3 T M2M33 () N V2 V3 T M2 M3
14 RHS 150x75x3 Bottom Center O O O
4 Diagonals Hiddle Center M N V2 V3 T M2M33 () N V2 V3 T M2 M3
1 SHS 75x75%3 Middle Center [ M ™ O [
3 SHS 75x75x3 viddle Center I~ 7 O W ¥
5 SHS 75%75%3 dle Center [ M & O [~
7 SHS 75x75x3 dle Center LM - O Vv
9 SHS 75%75%3 jddle Center [ M & O |2~
11 SHS 75x75x3 Middle Center LM > O Vv
4 Verticals Middle Center () N V2 V3 T M2 M33 () N V2 V3 T M22 M33
2 SHS 75x75x3 Middle Center [ M & O W
4 SHS 75x75x3 dle Center [ v & O W
6 SHS 75%75x3 Middle Center [ M & O W
£ SHS 75%75x3 [ v W O W
10 SHS 75x75x3 Middle Cente [ v W O [
Horizontals SHS 75x75x3 -+| Middle Center () N V2 V3 T M2 M33 (J) N V2 V3 T M22 M33

» Change the truss member sections to the following by click on the section name:

e Top & bottom chord = RHS 150x75x3 (Singapore)
e Diagonals & Verticals = SHS 75x75x3 (Singapore)

» Click OK to exit the Truss Generator dialog.

The truss will be inserted. The truss insertion will automatically switch into copy mode & you can pick
the next point of insertion.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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» Insert 3 nos. of similar trusses by clicking grid
intersection B/1, C/1 & D/1

»  Press ESC or Right-Click to end the copy
operation.

To enter copy mode manually, select the truss 2>
Right-click = Pick Copy
» Select the basepoint @ intersection of A/1

» Insert 3 nos. of similar trusses by clicking grid
intersection B/1, C/1 & D/1

Purlins Creation

We will now insert purlins on the roof trusses. Purlins are best inserted using the 3D view.

> Click on Purlin toolbar button ** = Insert Using Two Members

» Select the first truss @ GL A =2 Select the last truss @ GL D (Intermediate trusses will be
automatically found)

» Another insertion method is by Insert Using Multiple Members. Click Enter after all the members
needed are selected.

»  On Purlin Dialog, you can specify the following:

e Profile / Section of the for the Purlin.
e Section Alignment: On the Section / Under the Section / Centered / Align To Top / Bottom.
e Generation Method: By Truss Joints / By Spacing.

e Todesign the purlin as continuous, tick Continuous Purlin. Edit Continuous Purlin max length
in Settings Center > Steel Settings > Member Design Tab > Max. Member Length.

e There are many other options. Refer to the diagrams as a guide.

e The 3D diagram on the right can be rotated (right-click & drag) & zoom in/out (mouse wheel)

EEL Purdin O p'e
Label: 2F1 § | Section Properties '\
Tap Profile UPN 100 <} =
General Bottom Profile Fiong
Section Alignment On The Top Chord ©On The Section —
Geometry Section Alignment On The Bottom Chord ©On The Section -
SagRods G tion Options
I Continuous Purlin |
Placement Top Chord

Generation Method By Truss Joints

Default

Spacing
Delete First Member
Delete Last Member

Lokt Comilonine Lanath, La O mm

Local Axes

| Display

X ons

=

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"



(3 PROTAETENE page s

» Choose section UPN100 (under Steel = European sections = UPN)

Purlin Steel (PFC 100x50)

Database | Project

H

80
© i
120

» In the Sag Rods dialog = Insertion Method = Choose None to remove all sag rods (for simplicity)
LL purlin

Label: 2p1 [PrC 1[5~ | 530 Rods

Insertion Method
General
Geometry
Sag Rods

» Pick OK to exit the purlins dialog.

We will insert the roof loading using the more specific Cladding function.

Creating Cladding & Loads
» Go to Modelling tab = Pick Cladding < 2 Select any purlin.

The Cladding dialog will appear to insert roof loads on the purlins.

In the Geometry dialog, the cladding geometry can be adjusted by selecting the point and changing
the values in the vertical and horizontal direction.

In the Loads dialog, loading of the cladding can be input here.

G CEEEIE Point  Horizontal Dir Vertical Dir

Label: 1|8 Group 1-P1f

0.00 mm 0.00mm
0.00 mm 0.00mm
0.00 mm 0.00mm
.00 mm 0.00mm

<

General

X/
w

Geometry
Loads

Qe 000060000
ggdegegéees
-

B

Label: w1|d

Self Weight: 0.00kN/m2 | (S
General |Dead Load: 0.50 m;mz|||[§§
Geometry Live Load: 0.00 kM/m2 51%
z
T > Loads | Roof Live Load: 0.70 kNj'mZ”
-
" Snow Load: 0.00 kM/m2
Rain Load: 0.00 kMN/m2

» Input the loads value in the Loads Dialog; Dead Load (G) = 0.50 kN/m2 and Roof Live Load (Qr) =
0.70 kN/m2. The loads input will be assigned onto the whole cladding area.

» Click OK to exit the cladding dialog > The cladding will be rendered on top of the purlins.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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» Alternatively, to input cladding load, go to the Structure Tree > Cladding > Select the cladding label

4 7 Claddings 1fi- Edit Loads
» Right-click > Pick Edit Loads |i

The load editor dialog will appear, which allows you to insert area load on the cladding.

View Options

Select Members by picking or drawing a window for Load Assignment

'
E
N | Y.‘ ©” i

At the top, pick Full Uniform Area Load
Pick G Load Case in the left pane.

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.5 kN/m?
Click & drag window over the entire roof cladding to apply all panels.

Pick Qr Load Case (Roof Live) in the left pane & Full Uniform Area Load

In Load Properties, ensure Load Direction = Gravity & Magnitude = 0.7 kN/m?
Click & drag window over the entire roof cladding to apply all panels.

Click OK to save & exit the load dialog.

=

You can switch off the cladding Layer # - by going to the Display tab > Layers.

YV VY V V V V V V V

This operation will make the view less cluttered & make the selection of other members easier.

Braces Creation

We will now insert some bracings between steel columns.
> Click on the Brace toolbar icon %

» Pick two adjacent columns at A/1 & B/1 - Brace Dialog will appear.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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Brace

Brace Group Count Label: x2|$ Reset View
Count 1 Sy s
Section a
1 2 RES
Profile L80X8
Align to Shorter Member
Brace Type X Brace
Out of Plane Alignment Center F
Out Of Plane Offset 0mm F 1 _|
In Plane Alignment Original
Divide v

Model joints as fixed
Properties of Frame 1 (F1)

1End x-Offset 2! 0mm
1End y-Offset 0 mm
. | JEnd x-Offset omm
i | JEnd y-Offset omm
Frame Rotation -80.0 ®
Properties of Frame 2 (F2)
1End x-Offset 0 mm
1End y-Offset 0mm
JEnd x-Offset 0mm
JEnd y-Offset 0mm ;
Frame Rotation 50.0°° F1-J ,

F2

» In the Brace dialog, you can specify the following:

Profile / Section of the for the braces

Brace Type (Diagonal, X Brace, Y Brace or K Brace)
Alignment & Top/Bot Offsets

Apply to analysis: offsets will affect the analytical model.
Accept all defaults & click OK.

Insert the same bracing between columns A/3 & B/3

Y V

» Check the braces are correctly inserted, as shown below

(y)
)

» Insert new brace between columns C/3 & D/3

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Brace

Brace Group Count Label: 3|8 Reset View

Count 1 <>
Section and Type

1 3

Align to Shorter Membe: Profile L80X8

N to Shorter Member
= Brace Type <]

Out of Plane Alignment Center F
Out Of Plane Offset 0mm
In Plane Alignment Original

Invert
Model joints as fixed
Properties of Frame 1 (F1)

1End x-Offset 0mm
1End y-Offset 0mm
. | JEnd x-Offset 0 mm
JEnd y-Offset F1 .
Frame Rotation -90.0 °

x
v o |[X concl
» Change Brace Type to Diagonal
» Input J End y-Offset = 3000 mm (rest remains 0 mm)
» Click OK = Diagonal Brace will be inserted.
» Insert another new diagonal brace between the same columns C/3 & D/3.
Brace
Brace Group Count Label: 4|8 Reset View
ount 1 - <4 —
ign to Shorter Member Brace Type Diagonal <
Out of Plane Alignment Center
Out Of Plane Offset 0mm
i::’:tne Alignment Orl
Model joints as fixed
Properties of Frame 1 (F1)
1 End x-Offset 0 mm
==
t | JEnd y-Offset omm F1 =~
Frame Rotation -80.0°
F1-J L: :
X
v oK X cancel
» Ensure Brace Type = Diagonal
» Tick Invert =2 this will invert the diagonal.
» The input | End y-Offset = 3000 mm (rest remains O mm).
» Click OK =2 A new diagonal brace will be inserted.
» Check the braces are correctly created in the 3D view as below.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM"
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Horizontal Brace Frame  Horontal Brace Frame
= sl 0
— — T P g >
D T L . Analytical Offsets
Sl 7 1 A I-€nd JEnd
e H 18
== 7 P tbe Fily x[ omm| x[ om
e Type: |Horizontal ... | v ¥ omm| y: 0mm
Storey (I-)): z: omm| 2 omm
Storey (I-)):

Analytical Wire Ref. Point: 6

Section:
ddle Center

* 3| Middle Center
Physical Offsets

0.0°|[Z Out-Of Plane: 0mm

In-Plane: -80 mm
= >
Insertion Method: | /] |1 1™

Plane Normal Angle:

Angle:

Apex Distance:

End Releases
N V2 V3 T M2 M3
I v v
] v

Model 3 horizontal
braces

Horizontal braces can also be inserted between beams. Create 3 nos. horizontal braces connecting the
beams in STO1, as shown above.

> Go to Frame dropdown, pick Horizontal Brace Frame * "o frecefame

Horizontal Brace Frame dialog will appear. We will just use the default “L” section.

» Go to 3D tab > Physical Offsets > Change In-Plane = -80 mm (top of section aligns with beam top)
Physical Offsets changes the position of a member in the 3D view but does not affect the analytical position
in the analysis (changed by Analytical Offsets).

» Pick the 2 insertion points for the brace ends to create 3 nos. horizontal braces (as shown above).

» Click OK to close the dialog.

When modelling steel members, it may be easier to switch to analytical Linear view :

» Go to 3D view > By default a "Solid" or "Rendered" model is shown.

[rE—

Rendered

» Press "CTRL + D" consecutively to change to “Linear” to Display Style
» Ensure "Linear" is active > This is the 3D analytical wireframe model which will be analysed.
» Verify the members are connected properly by zooming in common joints of interest.

It is important to check member connectivity before the analysis, otherwise analysis may fail or yield many
warnings of instability.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM"
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Girts Creation

We will now insert some girts between steel columns.

»  Click on Girt toolbar button n

»  Select the first column at grid A/3 =2 Select the last column at grid D/3.
Intermediate columns will be automatically found.

» In the Geometry dialog, you can specify the following:

e  Profile / Section of the Girt
e  Section Alignment: On The Section / Under The Section / Centered / Align To Top / Bottom
e  Spacing, Delete Bottom / Top Member, Left / Right Cantilever, Offsets

~ Girt o IEH
Label: 2G2 { | Section Properties
Profle UPN100
General Section Alignment On The Section

Generation Options E’

Geometry Fill From Top

Sag Rods Spacing s 1000.m 4
Delete Bottom Member
Delete Top Member %
Left Cantilever Length Le 0Omm
Right Cantilever Length Re omm
Gap Between Continuous Purlins d 0mm
Offsets

Load Display Mode

Perpendicular Offset Vo 0mm

T Momb e OEEant Aa P

Local Axes

v oK X cancel

The insertion of the girts depends on the sequence of clicking the members as this will determine the
correct Section Alignment. For example, if you click the column at A/1 followed by the column at D/1,
the girts will be placed at the right-hand side of the column i.e., at the internal part of you structure
when Section Alignment = On the Section. Therefore, you will have to change Section Alignment = Under
the Section if you would like to have the girts modelled at the external part of the structure. Likewise, if
you click the column at D/1 followed by the column at A/1, the girts will be placed at the left-hand side
of the column i.e., at the external part of you structure when Section Alignment = On the Section.

Inserting the girts b clicking on the members at any sequence are both correct so long as you define the
section alignment correctly to ensure that the girts are modelled correctly.

»  Ensure Profile is UPN100 (under Steel = European sections = UPN)

»  Ensure Section Alignment is On The Section.

» Tick “Delete Bottom Member” so that bottommost Girt is removed.

In the Sag Rods dialog, you can specify the configuration of the sag rods. For simplicity, we will not
insert the sag rods for this model, as they are minor elements.

ProtaStructure® ProtaSteel ProtaDetails’ ProtaBIM’
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Page - 92

» Inthe Sag Rods dialog = Insertion Method = Choose None to remove all sag rods

 Girt
H -
Labe 2G2(8 Sag Rods
Insertion Method
General
Geometry
Sag Rods

None | v

> Click OK, and the girts will be inserted.

» Insert similar girts between columns A/1 & D/1 but Section Alignment = Under the Section.

>  Check the girts are inserted correctly at both sides of the building, as shown below.

A)

/

\/
N

.,_
/

Loads can be applied to girds similar to Purlin by creating a cladding first. For simplicity, we will skip this.

Column Splice Creation

storey level.

rd Edit Selected Splice

Ref, Storey No;
Spiice Distance:

Splice Width:] | 500

Member Spice Definitions

1 v

x Delete Selected Splice

ProtaStructure’

v X
oK Cancel
ProtaSteel’

Press ESC to deselect all members.

Select the corner column at GL D/3

Right-click = Define Splice

Pick Add New Splice in Splice Location Definitions
In Member Splice Definition choose :

YV V V V V

e Reference Strorey =1
e Splice Distance (from floor level) = 800 mm
e Splice width =500 mm

» Click OK

The splice will be created & listed in Splice Location
Definitions.

» Close Splice dialog

ProtaDetails’ ProtaBIM"
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Building Analysis
» Go to the Analysis tab = Pick Building Analysis
> In Batch Design Options, choose not the design any members = click Building Analysis
Analysis should complete if there is no serious modelling mistakes.
» Review the results in the Analytical Model view to your satisfaction as outlined in previous section.
For example, check if the roof cladding loads have been correctly considered by switching on the Frame
Loads & Frame Load Labels.
Steel Design
Steel member design commands can be accessed via the Design tab.
Sbigteint My Lok Aeies vy | O | Ovosiemfeprts B Diley e i

=8 T 0 w i = T < gp % s&<=[I I Xoda

Design Columns ~ Storey Prestressed RibBeams Foundation Slab Analysis Ribbed Slab  Pad Footings Pile Caps Column Beams Slabs Ribbed Columns Frames Eraces Purins Girts  Trusses

Al Beams Beams Beams and Design Analysis Punching Check Slabs
Design Reinforced Conarete Deflection/Crack Chedk Steel

» Go to Design tab = Design All =2 Pick Steel Member Design Check = OK.

+» This will check all the adequacy of assigned all steel members in one go.

¢ The program does not automatically select the smallest section size.

«» If the model is large, it is recommended to perform design check by member types separately.
+» To access a summary of member design check, select the steel member icons in the steel group.

+» To design only a single member, select it = Right-click > Steel Member Design

»  Pick steel Column Design T to access the design summary of all steel columns.

Steel Column Design
I ; ;I:]’: ‘i’ f [3f Mark all for print IEI1 IEI" X
Check Check  Filter 3 @ Remove all print marks Design  Detailed Close
Selected All R Report Report
0
Member Label Storey Print | Section Material Section Class Slenderness Ratio (kL/fr) Utilization Ratio Design Status Governing Check
2C1 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass v (Combined)
202 2 v UB 250x250x67 5355 Class1 95 < 200 0.15 < 1.00 Pass v (Combined)
203 2 d UB 250x250x67 §355 Class1 95 < 200 0.15 < 1.00 Pass (Combined)
204 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass (Combined)
205 2 v UB 250x250%67 5355 Class1 95 <200 0.05 < 1.00 Pass + (Combined)
206 2 o UB 250x250x67 5355 Class1 95 < 200 0.14 < 1.00 Pass (Combined)
207 2 W UB 250x250x67 5355 Class1 95 < 200 0.13 < 1.00 Pass (Combined)
08 2 W UB 250x250x67 5355 Class1 95 < 200 0.05 < 1.00 Pass / (Combined)
ics 1 ' UB 250x250x67 5355 Class1 48 < 200 0.01 < 1.00 Pass (Combined)
1C9 1 |  UB250x250x67 | S355 Class1 48 < 200 0.03 < 1.00 Pass v (Combined)
1c10 1 o UB 250x250x67 5355 Class1 48 < 200 0.03 < 1.00 Pass (Combined)

Total number of members: 11

» Double-click on any column to review the detailed design checks.

ProtaStructure” ProtaSteel ProtaDetails’ ProtaBIM’
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v
x
v

Check
Design

58
Change
Section

Design
Report

| Design Summary

—
I Parame(ersl

II"“
h

Stations

e
A

Show Design  Show Diagrams Detailed

Iy

OK

Report

[ N ]
Local 2
L s ]
Local 3

Section UB 250x250x67
Section Width 245 mm
Section Height 248 mm
Flange Thickness 13 mm
Web Thickness 8 mm
Section Area 0.0085m2
Shear Area 3 0.0065 m2
Shear Area 2 0.0020 m2
Torsional Constant 4.670E-07 m4
Moment of Inertia 33 9.931E-05m4
Moment of Inertia 22 3.348E-05m4
Radius of Gyration 33 108 mm
Radius of Gyration 22 63mm
Elastic Section Modulus 33 8.010E-04m3
Elastic Section Modulus 22 2.690E-04m3

General Parameters
Design Code:
Partial Resistance Factors:
Effective Length:
Section Classification

Section Class:

» G etails

Check for Combined Forces

Utilization Ratio:
Critical Position:

Axial Compression Check

Utilization Ratio:
Critical Position:

» Csiculation Details

Shear Check

U. Ratio Major (2):
Critical Position:
U. Ratio Minor (y):
Critical Position:

» Cskulstion Details

Torsion Check

Utilization Ratio:
<

Steel Column Design - 2C1 (UB 250x250x67)

v X

Cancel

Eurocode 3 (SG)

yMO = 1.00 yM1 = 1.00 yM2 = 1.00
Kx = 1.00 Ky = 1.00 Lx = 1000 mm
Class1

0.052 <1.00v 6.3.3(4)-6.61

(500.00 - 1,000.00) mm

0.011 <1.00v
(5,500.00 - 6,000.00) mm

0.015 < 1.00v
(0.00 - 500.00) mm
0.000 < 1.00v
(500.00 - 1,000.00) mm

0.001 <1.00v

C1=1.00

Ly =6000mm  Lb = 6000 mm

>
>
>
for pass/fail.
>
>
>
>
Buckling length.
>

Check Design = Re-check the design of this column.

Design Report = Prepare the design report.

Parameters Tab > Deflection 2 Manually edit deflection limits.

Click on the triangle ™ next to the title check to drill down to more details.

Change Section =2 Allow you to pick another section = New section will be checked automatically

Show Design Stations =2 List out all the design forces of all load combinations.
Show Diagrams = Show design force diagrams for load cases, load combinations & envelope.

Parameters Tab > Buckling = Input Braced length, Buckling Length Coefficient, Lateral Torsional

Effective lengths are automatically detected & calculated by the program based on restraints provided
by connected members. You can change them if you wish.

ProtaStructure’

ProtaSteel’

ProtaDetails’
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Design Summary | Parameters I

Bucking | Deflection

I | Manually edit the buckling parameters I

Check Design

Page - 95

» Go to the Parameter tab.
» Tick Manually edit buckling parameters.

> Input various Braced Length

R/

+* ‘0’ (Zero) means auto-calculate values. Hence, only
input values to over-write them.

< It is highly recommended you review the auto-
calculated values and amend to suit your design
assumptions.

» Go back to Design Summary to check the design.

+» Deflection limits can be modified using similar
steps.

Braced Length Major, Lx: 1000 mm
Braced Length Minor, Ly: 0mm
Buckiing Length Coeffident Major, Kx: 0.000 X
Buckiing Length Coeffident Minor, Ky: 0.000
Distance between transverse stiffeners: 0 mm
Lateral Torsional Buckling Length, Lb: 0 mm
LTB Moment Coefficent, C1 0.000

» Pick OK to close the column design dialog.

> Pick Trusses @2 to design the trusses.

Steel Truss Design

I E II;: Y @ Mark all for print i% h..'l] x

v
Check  Check  Filter @ Remove all print marks  Design Print Close
Selected Al Report Table View

0

Member Label Storey | Print |Section Material Section Class Slenderness Ratio (kL/r) Utilization Ratio |  Design Status Governing Check
211 2 v|  RHS 150x75x3 5355 Class1 315 > 200 0.32 < 1.00 Pass v (Combined)

212 2 v|  RHS 150x75x3 5355 Class1 315 > 200 0.83 < 1.00 Pass (Combined)

213 2 «|  RHS 150x75x3 5355 Class1 315 > 200 0.82 < 1.00 Pass (Combined)

214 2 |  RHS 150x75x3 S$355 Class1 315 > 200 034 < 1.00 Pass (Combined)

Total number of members: 4 T

The design status shows pass as Utilization Ratio is less than 1.

Slenderness Ratio check is a minor check to ensure sections are not too slender. It is up to the designer

whether to increase the member size to pass this check.

» Double-click on the truss 2T2 to access the detailed steel truss design.

ProtaStructure” ProtaSteel ProtaDetails’
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Total number of members: 14

Selected member coloured purple

Page - 96
272 - Steel Truss Design
Design
I v — o
- I x Ig.g V — i":"ll ~ ES - L 4 X
Check Check Change Filter Report Reset ShowLabels Show Utilization oK Cancel
Selected All Section View Ratios
Type a /O
Members Section Material Slenderness Ratio (kL/r) Deflection (mm) Utilization Ratio Design Status Governing Check
2F12 RHS 150x75x3 5355 53 =200 0.7 < 27.8 (L/360.0) 0.39 < 1.00 Pass (Combined) ~
2F13 RHS 150x75x3 5355 53 =200 0.7 < 27.8 (L/360.0) 0.39 < 1.00 Pass v (Combined)
4 Type: Bottom Chord
2F14 RHS 150x75x3 5355 315 > 200 2.4 < 27.8 (L/360.0) 0.83 < 1.00 Pass v (Combined)
4 Type: Vertical
2F2 SHS 75x75x3 5355 43 < 200 0.05 < 1.00 Pass v (Axial Compression)
2F4 SHS 75x75x3 §355 35 <200 0.11 < 1.00 Pass v (Axial Compression)
2F6 SHS 75x75x3 5355 51<0 0.01 < 1.00 Pass v (Axial Tension)
2F8 SHS 75x75x3 S355 43 = 200 0.05 < 1.00 Pass v (Axial Compression)
2F10 SHS 75x75x3 5355 35 = 200 0.11 < 1.00 Pass v (Axial Compression)
4 Type: Diagonal
2F1 SHS 75x75x3 5355 722200 0.00 < 1.00 Pass / (Axial Compression)
2F3 SHS 75x75x3 5355 \ 67=0 0.10 < 1.00 Pass v (Axial Tension)

1.00 -

0.85
0.70

0.00

G B YV VYV VY

K/
L4

A\

Show Label = Show the truss member label.

Pass / Failed members are shown clearly in Green / Red

Reset View =2 Reset the truss diagram to the original orientation.

Show Utilization Ratios = Show Utilization ratio for each member.

Fail members (UR > 1) will be coloured red in the truss diagram.

The selected member in the table will be coloured purple in the truss diagram.

ProtaStructure’

ProtaSteel’

ProtaDetails’

ProtaBIM"

Slenderness Ratio failure will not result in FAIL status as it is not a critical criterion (more a warning)

The truss diagram at the bottom can be zoomed (mouse wheel) & rotated (right-click & drag).

Double-click on the bottom chord member = This will bring up detailed member design.
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Steel Bottom Chord Design - 2F 14 (RHS 150x75x3)
I I &= T ORI P
x \" %
v 58 h [ B 4
Check Change Design Show Design Show Diagrams Detailed oK Cancel
Design Section Report Forces Report
Design Summary Parameters
Local 2 General Parameters
Design Code: Eurocode 3 (SG)
Partial Resistance Factors: M0 = 1.00 yM1 = 1.00 yM2 = 1,25 Cl=1.00
Effective Length: Kx = 1.00 Ky = 1.00 I Lx = 1668 mm Ly = 10000 mm Lb = 10000 mm I
Supports I =None J =None
End Releases I = Fixed ] = Fixed
Local 3
Section Classification
Section Class: Class1
» Cakulstion Details
Check for Combined Forces
Utilization Ratio: 0.826 < 1.00 v
Section RHS 150x75x3 "
Critical Position: (0.00 - 10,000.00) mm
Section Width 75 mm b Caloulstion Detsils
Section Height 150 mm
Wall Thickness 3mm | | Axial Compression Check
Section Area 0.0013m2 Utilization Ratio: 0.776 < 1.00 v
Shear Area 2 0.0009 m2 Critical Position: (0.00 - 10,000.00) mm
Shear Area 3 0.0005m2| | p Cakulstion Details
Torsional Constant 3.120E-06 m4
Moment of Inertia 22 1,300E-06 m4 | | Aodal Tension Check

In steel design, it is important to check the effective lengths detected as it will directly impact the Axial
Compression & Combined Forces Check. In the results, General Parameter, notice the bottom chord, Lx
=1668 mm & Ly = 10,000mm.

e |xisthe Major Braced Length = truss panel length as there are vertical & diagonal members.
e Ly & Lbis the Minor Braced Length is the entire length of the bottom chord between column

supports.
Ly LX
A 1 A
X

If there is failure axial compression check, you may increase the section size or thickness to solve the
failure.

You may also reduce the minor bracing lengths bottom chord, by adding bracing members at
intermediate locations joining bottom chords of the adjacent truss.

Alternatively, go to the Parameter > Buckling tab to manually edit the bracing lengths.

> If there is a bracing member at the mid-span of the bottom chord, you can change the braced
length Minor, Ly & Lateral Torsional Buckling Length, Lb to 5000 mm.

» Click on Design Summary, and the member will automatically be re-checked.

The assumption of top chord is:
e Lxis the Major Braced Length is auto determined = truss panel length

e Lyis the Minor Braced Length is auto determined = purlin spacing

You may want to check the other frame member design. The design interface is similar to the column
design.

ProtaStructure® ProtaSteel’ ProtaDetails’ ProtaBIM’
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Design Status & Design Utilization

Page - 98

We can view Steel Design Status and Steel Design Utilization to review pass/failure status & design

efficiency quickly.

The design status can be displayed graphically in the plan or 3D window.

» Click on the 3D view to make it active.

—
» Go to the Review Tab and pick Design Status 5ok

Design Status

. Fall
D Warning
D Expired Analysis
B o«

. Do not design

[ notDesigned

> Click Visual Interrogation ** & choose Steel Design Utilization Ratios = OK

Active Windows Settings and Visual Interrogation

coloring: Reset Al Fitters
Scene Settings Criteria for recoloring

Entity Edges Loads "~
Hiddenline Properties Bean Wall Loads

Slab Additional Dead Loads

Slab Live Loads

Members with User Defined Loads
Beam Plan Display Beams using F.E. Slab Loads

Visibility Filters

Column Display

Slab Plan Display Beams Using F.E. Slab Analysis Results

Members with Temperature Difference

FE Contours

Animation

Building Assessment - Member Damage Regions
Building Risk Assessment Status
Model
Wall Groups
Seismic Isolators

OK

ProtaStructure® ProtaSteel’

Design Utilization Ratios

-0

[Joss-1.00
[Joro-oss
W os0-070
O <os0
DNmDeslgned
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Thank You

Thank you for choosing the ProtaStructure Suite product family.
Our top priority is to make your experience excellent with our software technology solutions.

Should you have any technical support requests or questions, please do not hesitate to contact us at all
times through globalsupport@protasoftware.com and asiasupport@protasoftware.com

Together with our responsive technical support team, our dedicated online support center is available
to help you get the most out of Prota’s technology solutions.

The Prota Team
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